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(Intermediate)


To reproduce the shape effects on this slide, do the following:
On the Home tab, in the Slides group, click Layout, and then click Blank.
On the Home tab, in the Drawing group, click Shapes, and then under Rectangles click Rectangle (first option from the left). On the slide, drag to draw a rectangle.
Select the rectangle. Under Drawing Tools, on the Format tab, in the Size group, do the following: 
In the Shape Height box, enter 3.17”.
In the  Shape Width box, enter 9.5”.
Drag the rectangle slightly above the middle of the slide. 
Select the rectangle. On the Home tab, in the Drawing group, click Arrange, point to Align, and then do the following:
Click Align to Slide.
Click Align Left.
Under Drawing Tools, on the Format tab, in the Shape Styles group, click the next to Shape Outline, and then click No Outline.
Under Drawing Tools, on the Format tab, in the Shape Styles group, click the Format Shape dialog box launcher. In the Format Shape dialog box, click Fill in the left pane, select Gradient fill in the Fill pane, and then do the following:
In the Type list, select Linear.
In the Angle box, enter 0. 
Under Gradient stops, click Add gradient stops or Remove gradient stops until two stops appear in the slider.
Also under Gradient stops, customize the gradient stops as follows:
Select the first stop in the slider, and then do the following: 
In the Position box, enter 0%.
Click the button next to Color, and then under Theme Colors click Orange, Accent 6, Darker 50% (fifth row, 10th option from the left).
Select the next stop in the slider, and then do the following: 
In the Position box, enter 100%.
Click the button next to Color, and then under Theme Colors click Orange, Accent 6, Darker 25% (fourth row, 10th option from the left).


To reproduce the “heading” text box on this slide, do the following:
On the Insert tab, in the Text group, select Text Box. On the slide, drag to draw a text box.
Enter the heading text, and then select text. On the Home tab, in the Font group, do the following:
In the Font list, select Calibri.
In the Font Size box, enter 38.
Click Bold.
Click the arrow next to Font Color, and then under Theme Colors click Orange, Accent 6, Darker 25% (fourth row, 10th option from the left).
On the Home tab, in the Paragraph group, click Align Text Left.
Drag the text box just above the rectangle, in the right half of the slide. 


To reproduce the second text box on this slide, do the following:
On the Insert tab, in the Text group, click Text Box. On the slide, drag to draw a text box.
Enter three lines of text with paragraph breaks, and then select the text. On the Home tab, in the Font group, do the following:
In the Font list, select Calibri.
In the Font Size list, select 28.
Click Bold.
Click the arrow next to Font Color, and then under Theme Colors click White, Background 1 (first row, first option from the left).
On the Home tab, in the Paragraph group, click the Paragraph dialog box launcher. In the Paragraph dialog box, do the following:
On the Indents and Spacing tab, under General, select Left in the Alignment box.
Under Spacing, select 12 in the After box.
Drag the second text box onto the rectangle, below the “heading” text box. 


To reproduce the full-color picture on this slide, do the following:
On the Insert tab, in the Images group, click Picture. In the Insert Picture dialog box, select a picture, and then click Insert.
On the slide, select the picture. Under Picture Tools, on the Format tab, in the Size group, click the Size and Position dialog box launcher. In the Format Picture dialog box, resize or crop the image so that the height is set to 5.08” and the width is set to 2.61”. To crop the picture, click Crop in the left pane, and in the right pane, under Crop position, enter values into the Height, Width, Left, and Top boxes. To resize the picture, click Size in the left pane, and in the right pane, under Size and rotate, enter values into the Height and Width boxes.
Also in the Format Picture dialog box, click Glow and Soft Edges in the left pane, and then, in the Glow and Soft Edges pane, do the following:
Under Glow, click the button next to Presets, and then click Blue, 5 pt glow Accent color 1 (first row, first option from the left).
Click the button next to Color, and then under Theme Colors click White, Background 1 (first row, first option from the left).
Drag the full-color picture on top of the rectangle, to the left of the text boxes. 
On the Home tab, in the Drawing group, click Arrange, point to Align, and then do the following:
Click Align to Slide.
Click Align Top. 


To reproduce the second picture on this slide, do the following:
On the Insert tab, in the Images group, click Picture. In the Insert Picture dialog box, select the same picture, and then click Insert. 
On the slide, select the picture. On the slide, select the picture. Under Picture Tools, on the Format tab, in the Size group, click the Size and Position dialog box launcher. In the Format Picture dialog box, resize or crop the image so that the height is set to 2.44” and the width is set to 2.61”. To crop the picture, click Crop in the left pane, and in the right pane, under Crop position, enter values into the Height, Width, Left, and Top boxes. To resize the picture, click Size in the left pane, and in the right pane, under Size and rotate, enter values into the Height and Width boxes.
On the slide, drag the new picture directly below the first one, and then, in the Format Picture dialog box, in the Crop tab, under Picture Position, adjust the Offset X and Offset Y settings to align the content of the two images so that they appear continuous.
Also in the Format Picture dialog box, click Picture Corrections in the left pane, and in the Picture Corrections pane, under Brightness and Contrast, do the following:
In the Brightness box, enter 70%.
In the Contrast box, enter -70%.
Select the smaller picture. On the Home tab, in the Drawing group, click Arrange, point to Align, and then do the following:
Click Align to Slide.
Click Align Bottom. 
Press and hold CTRL, and then select both pictures. On the Home tab, in the Drawing group, click Arrange, point to Align, and then do the following:
Click Align Selected Objects.
Click Align Center.  


To reproduce the animation effects on this slide, do the following:
On the slide, select the “heading” text box. On the Animations tab, in the Advanced Animation group, click Add Animation, and then under Entrance click Fade.
On the Animations tab, in the Timing group, in the Start list, select With Previous.
On the Animations tab, in the Timing group, in the Duration box, enter 2. 
On the Animations tab, in the Timing group, in the Delay box, enter 1.5.
On the slide, select the “heading” text box. On the Animations tab, in the Advanced Animation group, click Add Animation, and then under Motion Paths click Lines.
On the Animations tab, in the Timing group, in the Start list, select With Previous.
On the Animations tab, in the Timing group, in the Duration box, enter 2. 
On the Animations tab, in the Animation group, click Effect Options, and then click Left.
On the Animations tab, in the Animation group, click Effect Options, and then click Reverse Path Direction.
On the slide, select the motion path for the “heading” text box, point to the starting point (green arrow) of the motion path until the cursor becomes a two-headed arrow. Press and hold SHIFT, and then drag the starting point about 1.5” off the left edge of the slide. (Note: If your lines of text are longer than in the example above, you may need to further increase the length of the motion path. ) 
On the slide, select the second text box. On the slide, select the “heading” text box. On the Animations tab, in the Advanced Animation group, click Add Animation, and then under Entrance click Fade.
On the Animations tab, in the Animation group, click the Show Additional Effect Options dialog box launcher. In the Fade dialog box, do the following:
On the Effect tab, in the Animate text list, select By Letter.
In the % delay between letters box, enter 5.
On the Timing tab, in the Start list, select After Previous.
In the Duration list, select 0.5 seconds (Very Fast).
On the Text Animation tab, in the Group text list, select By 1st Level Paragraphs.


To reproduce the background on this slide, do the following:
One the Design tab, in the Background group, click Background Styles, and then click Format Background. In the Format Background dialog box, click Fill in the left pane, select Gradient fill in the Fill pane, and then do the following:
In the Type list, select Radial.
Click the button next to Direction, and then click From Center (third option from the left).
Under Gradient stops, click Add gradient stops or Remove gradient stops until three stops appear in the slider.
Also under Gradient stops, customize the gradient stops as follows:
Select the first stop in the slider, and then do the following: 
In the Position box, enter 0%.
Click the button next to Color, and then under Theme Colors click White, Background 1 (first row, first option from the left).
In the Transparency box, enter 0%. 
Select the next stop in the slider, and then do the following: 
In the Position box, enter 40%.
Click the button next to Color, and then under Theme Colors click White, Background 1 (first row, first option from the left).
In the Transparency box, enter 0%. 
Select the next stop in the slider, and then do the following: 
In the Position box, enter 100%.
Click the button next to Color, click More Colors, and then in the Colors dialog box, on the Custom tab, enter values for Red: 232, Green: 227, and Blue: 216.
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บทสรุปสําหรับผูบริหาร 
 

สถานการณดานเศรษฐกิจและแรงงาน ไตรมาส 2 ป 2562 มีรายละเอียดสรุปไดดังนี้ 

       

 สภาพเศรษฐกิจ 
 

 

ผลิตภัณฑมวลรวมจังหวัด จังหวัดสมุทรสาครมีมูลคาผลิตภัณฑมวลรวมจังหวัด (GPP)  

ป 2559 เทากับจํานวน 366,207 ลานบาท แยกเปนภาคการเกษตร จํานวน 20,513 ลานบาท (รอยละ 5.60) 

และนอกภาคเกษตร จํานวน 345,693 ลานบาท (รอยละ 94.40) 

 ดัชนีราคาผูบริโภค ณ เดือนมิถุนายน 2562 เทากับ 101.0 การเปลี่ยนแปลงดัชนีราคา

ผูบริโภคของจังหวัดสมุทรสาครเดือนพฤษภาคม 2562  เม่ือเทียบกับเดือนมิถุนายน 2561 ดัชนีลดลงรอยละ0.1 

 ภาวะการลงทุน ในไตรมาส 2 ป 2562 มีการจดทะเบียนนิติบุคคลตั้งใหม จํานวน 341 แหง 

ทุนจดทะเบียน 1,781.92 ลานบาท โดยประเภทอุตสาหกรรมท่ีมีการจดทะเบียนนิติบุคคลตั้งใหมมากท่ีสุด คือ   

การขายสง การขายปลีก การซอมแซมยานยนต จักรยานยนต ของใชสวนบุคคลและของใชในครัวเรือน จํานวน 

132 แหง (รอยละ 39.01) สําหรับการจดทะเบียนตั้งโรงงานใหมในไตรมาสนี้ มีจํานวน 84 โรง เงินลงทุน

จํานวน 2,268.13 ลานบาทโดยประเภทอุตสาหกรรมท่ีมีการจดทะเบียนโรงงานมากท่ีสุด คือ อุตสาหกรรมพลาสติก 

จํานวน 20 ราย เงินลงทุน 355.87 ลานบาท 

 

สถานการณดานแรงงาน 
 

ไตรมาส 2 ป 2562 จังหวัดสมุทรสาครมีผูอยูในวัยทํางานหรืออายุ 15 ปข้ึนไป จํานวน 883,705 คน 

เปนผูอยูในกําลังแรงงาน จํานวน 707,496 คน จําแนกเปนผูมีงานทํา จํานวน 703,036 คน (รอยละ 99.37   

ของผูอยูในกําลังแรงงานท้ังหมด) ผูวางงาน จํานวน 4,460 คน (อัตราการวางงานรอยละ 0.60)  

การมีงานทํา  ในกลุมผูมีงานทําท้ังหมด จํานวน 703,036 คน เปนผูทํางานในภาคเกษตรรวม จํานวน 
50,169 คน (คิดเปนรอยละ 7.13 ของผูมีงานทําท้ังหมด) ในขณะท่ีนอกภาคเกษตรนั้นมีผูทํางานท้ังสิ้น จํานวน
652,867 คน (รอยละ 92.86 ของผูมีงานทําท้ังหมด) สาขานอกภาคเกษตรท่ีมีผูทํางานมากท่ีสุด ไดแก     
สาขาการผลิต โดยมีผูทํางานรวมท้ังสิ้นจํานวน 415,605 คน (รอยละ59.11 ของจํานวนผูมีงานทําท้ังหมด) 
รองลงมาไดแก สาขากอสราง 87,036 คน (รอยละ 12.38) ของใชในครัวเรือน 29,615 คน (รอยละ 4.21) 
สาขาการขนสง สถานท่ีเก็บสินคา และการคมนาคม 29,535 คน (รอยละ 4.20) และการจัดหาน้ํา บําบัดน้ํา
เสีย จํานวน 28,631 คน (รอยละ 4.07) ตามลําดับ 

  
   เม่ือพิจารณากลุมผูมีงานทําจําแนกออกตามระดับการศึกษาท่ีจบในไตรมาส 2/2562 

พบวา แรงงานสวนใหญมีการศึกษาในระดับมัธยมศึกษาตอนตนจํานวน 152,952 คน (รอยละ21.57 
ของจํานวนผูมีงานทําท้ังหมด) รองลงมาไดแกแรงงานท่ีมีการศึกษาอ่ืนๆ จํานวน 121,735 คน     
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(รอยละ 17.17) ระดับประถมศึกษาจํานวน 121,231(รอยละ 17.10) ระดับมหาวิทยาลัย จํานวน 
107,924 คน (รอยละ 15.22) มัธยมศึกษาตอนปลาย จํานวน 82,551 คน (รอยละ 11.64 ตามลําดับ 

 
   ในไตรมาส 2/2562 จังหวัดสมุทรสาครมีผูวางงานจํานวนท้ังสิ้น 3,404 ราย คิดเปนอัตราการ

วางงานเทากับรอยละ 0.5 ของกําลังแรงงานท้ังหมด ท้ังนี้เม่ือพิจารณากลุมผูวางงานจําแนกตามเพศแลวพบวา
เพศหญิงมีอัตราการวางงานนอยกวากวาเพศชาย 

 
แรงงานนอกระบบ ในป 2561 มีผูมีงานทําอยูซ่ึงเปนแรงงานนอกระบบ (นอกระบบประกันสังคม) ท้ังสิ้น 

จํานวน 160,818 คน ท้ังนี้แรงงานนอกระบบเหลานี้สวนใหญเปนแรงงานนอกภาคเกษตร โดยสาขาท่ีมีจํานวน
แรงงานนอกระบบสูงสุด ไดแก สาขาขายสง การขายปลีก จํานวน 40,417 คน (รอยละ 25.13 ของแรงงานนอก
ระบบท้ังหมด) 

 เม่ือพิจารณาแรงงานนอกระบบจําแนกตามอาชีพ พบวา อาชีพท่ีมีแรงงานนอกระบบทํางาน

อยูมากท่ีสุด ไดแก อาชีพพนักงานบริการและพนักงานในรานคาและตลาด จํานวน 67,401 คน (รอยละ 41.91ของ

แรงงานนอกระบบท้ังหมด) 

การจัดหางานในจังหวัด 

               ในไตรมาส 2 ป 2562 จังหวัดสมุทรสาครมีตําแหนงงานวางท่ีแจงผานสํานักงานจัดหางานจังหวัด

สมุทรสาคร จํานวน 1,573 อัตรา ในสวนของผูลงทะเบียนสมัครงานในไตรมาสนี้ จํานวน 871 คน ขณะท่ีผูไดรับ

การบรรจุงานในไตรมาสนี้ จํานวน 1,390 คน ตามลําดับ 

                อาชีพท่ีมีตําแหนงงานวางมากท่ีสุดไดแก อาชีพงานพ้ืนฐาน โดยมีตําแหนงงานวาง จํานวน 

818 อัตรา (รอยละ 52.00) และตําแหนงงานวางตามระดับการศึกษาท่ีตองการมากท่ีสุดคือระดับมัธยมศึกษา

จํานวน 669 อัตรา (รอยละ42.53) รองลงมาไดแกปวช.-ปวส./อนุปริญญา จํานวน 531 อัตรา (รอยละ 33.75)  

การจัดหางานตางประเทศ 

 ในไตรมาส 2 ป 2562 พบแรงงานในจังหวัดสมุทรสาครท่ีแจงความประสงคไปทํางาน 

ในตางประเทศ เพศชาย จํานวน 3 คน เพศหญิง จํานวน 5 คน 

คนตางดาว 

ขอมูล ณ วันท่ี 30 มิถุนายน 2562 จังหวัดสมุทรสาครมีคนตางดาวท่ีไดรับอนุญาตทํางานคงเหลือ
ท้ังสิ้น จํานวน 265,318 คน ซ่ึงเม่ือจําแนกตามลักษณะการเขาเมืองของคนตางดาว พบวา  

กลุมคนตางดาวเขาเมืองถูกกฎหมายมาตรา 9 ประเภทพิสูจนสัญชาติ จํานวน 160,093คน    
(รอยละ 61.64 ของคนตางดาวเขาเมืองถูกกฎหมายท้ังหมด) รองลงมา ไดแก มาตรา 9 ประเภทนําเขาตาม MOU 
จํานวน 95,850 คน (รอยละ 36.90) มาตรา 9 ประเภทท่ัวไป จํานวน 3,609 คน (รอยละ 1.39) และมาตรา 12 
ประเภทสงเสริมการลงทุน จํานวน 153 คน (รอยละ 0.05)สําหรับกลุมคนตางดาวประเภทชนกลุมนอยมี 
จํานวน 5,613 คน (รอยละ 2.11) 

         การพัฒนาฝมือแรงงาน 
 การฝกยกระดับฝมือแรงงานในไตรมาส 2 ป 2562 พบวา มีผูเขารับการฝกยกระดับฝมือ

แรงงานท้ังสิ้น จํานวน 260 คน เม่ือพิจารณาตามกลุมอาชีพ พบวา กลุมชางไฟฟา อิเล็กทรอนิกส คอมพิวเตอร    
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มีการฝกยกระดับฝมือแรงงานสูงสุด จํานวน 142 คน (รอยละ54.61) รองลงมาคือ ธุรกิจและบริการ             
จํานวน 118 คน  ท้ังนี้ผูผานการฝกยกระดับฝมือแรงงานในไตรมาสนี้ผานการฝกยกระดับฝมือแรงงานท้ังหมด
จํานวน 118 คน กําลังอยูในชวงฝก จํานวน 50 คน 

การทดสอบมาตรฐานฝมือแรงงาน 
 การทดสอบมาตรฐานฝมือแรงงานในไตรมาส 2 ป 2562 พบวามีผูเขารับการทดสอบ

มาตรฐานฝมือแรงงานท้ังสิ้น จํานวน 169 คน เปนกลุมชางชางไฟฟา อิเล็กทรอนิกส คอมพิวเตอร จํานวน 169 
คน ท้ังนี้มีผูผานการทดสอบมาตรฐานฝมือในไตรมาสนี้จํานวน 113 คน (รอยละ 100.0) 

การตรวจแรงงาน 

 การตรวจคุมครองแรงงาน  ในไตรมาส 2 ป 2562 สํานักงานสวัสดิการและคุมครองแรงงาน
จังหวัดสมุทรสาคร ไดดําเนินการตรวจสถานประกอบการท้ังสิ้น จํานวน 74 แหง สําหรับไตรมาสนี้มีลูกจางท่ี
ผานการตรวจหรือไดรับการคุมครองรวม จํานวน 11,934 คน ซ่ึงสถานประกอบการท่ีตรวจสวนใหญเปน 
สถานประกอบการท่ีมีลูกจาง 10-19 และ 20-49 คน จํานวน 17 แหง (คิดเปนรอยละ 22.97) 

การตรวจความปลอดภัยในสถานประกอบการ 

ในไตรมาส 2 ป 2562 มีการตรวจความปลอดภัยในสถานประกอบการท้ังสิ้น จํานวน 67 แหง 

ลูกจางท่ีผานการตรวจ จํานวน 17,219 คน และพบสถานประกอบการท่ีปฏิบัติไมถูกตอง จํานวน 42 แหง 

 

แรงงานสัมพันธ 

 ขอมูลองคการนายจาง ณ สิ้นไตรมาส 2 ป 2562 พบวา มีเพียงสมาคมนายจาง จํานวน 11 แหง 

สําหรับองคการลูกจาง มีเพียงสหภาพแรงงานในกิจการเอกชน จํานวน 30 แหง  

สถานประกอบการและผูประกันตนในระบบประกันสังคม 

 ในไตรมาส 2 ป 2562 ขอมูล ณ เดือนมกราคม 2562 จังหวัดสมุทรสาครมีสถานประกอบการ
ท่ีข้ึนทะเบียนประกันสังคม จํานวน 11,268 แหง สําหรับผูประกันตน จํานวน 456,302คน เม่ือพิจารณาจํานวน
สถานประกอบการจําแนกตามอุตสาหกรรม พบวา อุตสาหกรรมท่ีมีจํานวนสถานประกอบการมากท่ีสุด ไดแก 
การคา จํานวน 2,941แหง (คิดเปนรอยละ 26.96 ของสถานประกอบการท้ังหมด) 

 การใชบริการประกันสังคม  

 จํานวนผูประกันตนของจังหวัดสมุทรสาครท่ีมาใชบริการกองทุนประกันสังคม มีท้ังสิ้น จํานวน 
209,381 คน  (หรือรอยละ 100.00 ของจํานวนผูประกันตนท้ังหมด) โดยประเภทประโยชนทดแทนท่ีผูประกันตน
มาใชบริการสูงสุด ไดแก กรณีสงเคราะหบุตร จํานวน 144,770 คน (รอยละ 69.14) ของผูใชบริการท้ังหมด 
รองลงมา คือ กรณีเจ็บปวย จํานวน 30,887 คน (รอยละ 14.75) กรณีชราภาพ จํานวน 17,532 คน (รอยละ 8.73) 
กรณีวางงาน จํานวน 10,520 คน (รอยละ 5.02) ตามลําดับ 

เม่ือพิจารณาปริมาณการจายเงินประโยชนทดแทน จะพบวามีการจายเงินท้ังสิ้น จํานวน 357.51 
ลานบาท โดยกรณีชราภาพ มีการจายเงินสูงสุดถึง จํานวน 135.78 ลานบาทประโยชนทดแทนท่ีจาย รองลงมา 
ไดแก กรณีชราภาพ จํานวน 86.67 ลานบาท (รอยละ 24.241) กรณีสงเคราะหบุตร จํานวน 52.59 ลานบาท 
(รอยละ 14.71) กรณีวางงาน จํานวน 38.72 ลานบาท (รอยละ 15.12) และกรณีเจ็บปวย จํานวน 23.07 ลานบาท 
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(รอยละ 9.01) สวนกรณีท่ีจายเงินประโยชนทดแทนนอยท่ีสุด คือ กรณีทุพพลภาพ จํานวน 3.24 ลานบาท (รอยละ 
1.26)   

การเลิกกิจการและเลิกจางงาน 
 ในไตรมาส 2 ป 2562 มีสถานประกอบการ จํานวน 223 แหง ท่ีเลิกกิจการ โดยเปนสถานประกอบการ

ท่ีมีการจางงาน 1-9 คน จํานวน 297 แหงท่ีเลิกกิจการ (คิดเปนรอยละ 90.54 ของสถานประกอบการท่ีเลิกกิจการ
ท้ังหมด) และสถานประกอบการท่ีมีการจางงาน 10 คนข้ึนไป จํานวน 31 แหง ท่ีเลิกกิจการ (รอยละ 9.45) 
ท้ังนี้ ลูกจางท่ีถูกเลิกจาง มีจํานวน 1,380 คน โดยเปนลูกจางในสถานประกอบการขนาด 1-9 คน จํานวน 639 คน 
(คิดเปนรอยละ 46.30 ของลูกจางท่ีถูกเลิกจาง) และลูกจางในสถาน ประกอบการขนาด 10 คนข้ึนไป จํานวน 
741 คน (รอยละ 53.69)  

ขอมูลคนพิการ 
  ในไตรมาส 2/ 2562 จังหวัดสมุทรสาครมีจํานวนคนพิการท่ีข้ึนทะเบียนท้ังหมด จํานวน 12,015 
คน จําแนกตามเพศ พบวา เพศชาย จํานวน 6,638 คน คิดเปนรอยละ 55.24 และเพศหญิง จํานวน 5,377 คน 
คิดเปนรอยละ 44.75 ซ่ึงจะเห็นไดวาเพศชายมีจํานวนคนพิการท่ีข้ึนทะเบียนมากกวาเพศหญิง 

 ขอมูลผูสูงอายุ 
  ในไตรมาส 2/2562 จังหวัดสมุทรสาครมีจํานวนผูสูงอายุท้ังสิ้น 551,222 คน เพศชาย 
จํานวน 266,217 คน คิดเปนรอยละ 48.30 เพศหญิง 285,005 คน คิดเปนรอยละ 51.70 จําแนกตามพ้ืนท่ี 
พบวาอําเภอเมืองสมุทรสาครมีจํานวนผูสูงอายุท่ีสุด จํานวน 282,630 คน คิดเปนรอยละ 51.27 รองลงมา  
อําเภอกระทุมแบน จํานวน 171,192 คน คิดเปนรอยละ 31.05 และอําเภอบานแพว จํานวน 97,400 คน  
คิดเปนรอยละ 17.70 
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สภาพเศรษฐกิจจังหวัดสมุทรสาคร 

 

1.  บทนํา 

1) แนะนําจังหวัดสมุทรสาคร 

  “เมืองประมง ดงโรงงาน ลานเกษตร เขตประวัติศาสตร” จังหวัดสมุทรสาครตั้งอยู 

ภาคกลางของประเทศในเขตปริมณฑล อยูหางจากกรุงเทพมหานคร 30 กิโลเมตร เปนจังหวัดชายฝงทะเล 

อาวไทยมีพ้ืนท่ี 872.374 ตารางกิโลเมตร หรือประมาณ 545,216 ไร                

ดานภูมิประเทศ จังหวัดสมุทรสาคร มีลักษณะภูมิประเทศเปนท่ีราบลุมชายฝงทะเล     

สูงจากระดับน้ําทะเลประมาณ 1.00 - 2.00 เมตร มีแมน้ําทาจีนไหลผานตอนกลางจังหวัด ไหลคดเค้ียวตาม

แนวเหนือใตลงสูอาวไทยท่ีอําเภอเมืองสมุทรสาคร ระยะทางยาวประมาณ 70 กิโลเมตร พ้ืนท่ีตอนบนในเขต

อําเภอบานแพวและอําเภอกระทุมแบนมีความอุดมสมบูรณของดินและมีโครงขายแมน้ํา ลําคลองเชื่อมโยงถึง

กันกระจายอยูท่ัวพ้ืนท่ีกวา 170 สาย จึงเหมาะท่ีจะทําการเพาะปลูกพืชนานาชนิด และบางสวนเปนยานธุรกิจ 

อุตสาหกรรมและท่ีอยูอาศัย พ้ืนท่ีตอนลางของจังหวัดในเขตอําเภอเมืองสมุทรสาครอยูติดชายฝงทะเลยาว 

41.8 กิโลเมตร จึงเหมาะท่ีจะประกอบอาชีพประมงทะเล เพาะเลี้ยงสัตวน้ําชายฝงและทํานาเกลือ  

ดานภูมิอากาศ มีลักษณะภูมิอากาศเปนแบบฝนเมืองรอน เนื่องจากไดรับอิทธิพลจาก ลมบก 

ลมทะเล และมีลมมรสุมตะวันตกเฉียงใต พัดผาน ในชวงฤดูรอน จึงทําให มีความชื้นในอากาศสูง  

มีฝนตกปานกลาง ปริมาณเฉลี่ย 1,120 มิลลิเมตรตอป อุณหภูมิเฉลี่ยประมาณ 27-28 องศาเซลเซียส     

มีความชื้นสัมพัทธต่ําสุด 68 สูงสุด 75 (ท่ีมา: http://www.samutsakhon.go.th) 

วิ สั ย ทั ศ น จั ง ห วั ด ส มุ ท ร ส า ค ร  

“เมืองอุตสาหกรรมเชิงนิเวศ เกษตรและ

อาหารปลอดภัย ทองเท่ียวทางเลือกใหม 

สังคมเปนสุข” 

รูปท่ี 1 ลักษณะภูมิประเทศ 
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2) ขนาด ท่ีตั้ง อาณาเขต 

จังหวัดสมุทรสาครเปนจังหวัดชายทะเลตั้งอยูริมฝงแมน้ําทาจีนในเขตพ้ืนท่ีภาคกลางตอนลาง
ของประเทศไทย ประมาณเสนรุงท่ี 130 องศาเหนือ และเสนแวงท่ี 100 องศาตะวันออก เปนจังหวัดปริมณฑล 
หางจากกรุงเทพมหานครประมาณ 30 กิโลเมตร มีพ้ืนท่ี 872.347 ตารางกิโลเมตร หรือประมาณ 545,216 ไร 
มีอาณาเขตติดตอ ดังนี้ 

ทิศเหนือ      ติดตอกับจังหวัดนครปฐม  

ทิศใต       ติดทะเลอาวไทย  

ทิศตะวันออก      ติดตอกับกรุงเทพมหานคร  

ทิศตะวันตก      ติดตอกับจังหวัดสมุทรสงครามและราชบุรี  

 

รูปท่ี 2 แผนท่ีจังหวัดสมุทรสาคร 
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3) การปกครอง 

การปกครอง ประกอบดวย ราชการสวนกลางท่ีมีสํานักงานตั้ งอยู ในพ้ืนท่ีจั งหวัด 
37 หนวยงาน สวนราชการสวนภูมิภาค 32 หนวยงาน หนวยงานรัฐวิสาหกิจ 13 หนวยงาน แบงเขตการ
ปกครองออกเปน 3 อําเภอ ไดแก อําเภอเมืองสมุทรสาคร อําเภอกระทุมแบน และอําเภอบานแพว  
มี 40 ตําบล 290 หมูบาน 62 ชุมชน ดานการปกครองสวนทองถ่ิน ประกอบดวย 1 องคการบริหารสวน
จังหวัด 12 เทศบาล 25 องคการบริหารสวนตําบล (ตารางท่ี 1) 

ตารางท่ี 1  แสดงจํานวน อําเภอ ตําบล หมูบาน เทศบาล และ อบต. ในจังหวัดสมุทรสาคร  

อําเภอ 
พ้ืนท่ี 

(ตร.กม.) 
ตําบล หมูบาน เทศบาล องคการบริหารสวนตําบล 

เมืองสมุทรสาคร 
กระทุมแบน 
บานแพว 

492.040 
135.276 
245.031 

18 
10 
12 

116 
76 
98 

5 
4 
3 

12 
6 
7 

รวม 872.347 40 290 12 25 
ที่มา : ที่ทําการปกครองจังหวดัสมุทรสาคร 

1.2  ผลิตภัณฑมวลรวมจังหวัด 

จากขอมูลการรายงานผลิตภัณฑมวลรวมภาคและจังหวัดโดยสํานักงานคณะกรรมการพัฒนาเศรษฐกิจ

และสังคมแหงชาติ (สศช.) พบวา สภาพเศรษฐกิจของจังหวัดสมุทรสาครขยายตัวอยางตอเนื่อง โดยในป 2559 

จังหวัดสมุทรสาครมีมูลคาผลิตภัณฑมวลรวมจังหวัด (GPP) เทากับ 366,207 ลานบาท ประชากรมีรายไดเฉลี่ย

ตอคนตอป (GPP Per Capita) เทากับ 382,679 บาท โดยมีอัตราขยายตัวเพ่ิมข้ึน ระหวางป   2556 - 2559 

เฉลี่ยรอยละ 1.2 ตอป   

สําหรับผลิตภัณฑมวลรวมจังหวัด (GPP) ตามราคาประจําปมีมูลคาเทากับ 366,207 ลานบาท  

แยกเปนภาคการเกษตร 20,513 ลานบาท (รอยละ 5.60) และนอกภาคเกษตร 345,693 ลานบาท          

(รอยละ 94.40)  

สาขาหลักท่ีมีมูลคาสูงท่ีสุด ไดแก สาขาการผลิต 239,421  ลานบาท รองลงมาไดแก สาขาการขายสง

และการขายปลีก การซอมยานยนตและจักรยานยนต  49,190  ลานบาท และเกษตรกรรม การปาไม และการ

ประมง 20,513  ลานบาท ตามลําดับ สวนสาขาการผลิตท่ีมีอัตราการขยายตัวอยางตอเนื่องของจังหวัด ในชวงป 

2556 – 2559 ไดแก สาขาศิลปะ ความบันเทิง และนันทนาการ สาขากิจกรรมอสังหาริมทรัพย สาขากิจกรรม

ทางการเงินและการประกันภัย สาขาการขนสงและสถานท่ีเก็บสินคา และสาขาการขายสงและการขายปลีก 

การซอมยานยนตและจักรยานยนต 
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ตารางท่ี 3 มูลคาผลิตภัณฑจังหวัดสมุทรสาคร ณ ราคาประจําป จําแนกตามสาขาการผลิต  

พ.ศ. 2556 – 2559 

              (หนวย: ลานบาท) 

สาขาการผลิต 2556 2557 2558 2559 สัดสวน 
อัตราการ
ขยายตัว 

ภาคเกษตร 18,130  19,702  18,459  20,513  5.6 4.2 
เกษตรกรรม การปาไม และการประมง 18,130  19,702  18,459  20,513  5.6 4.2 

ภาคนอกเกษตร 298,368  317,316  326,438  345,693  94.4 5.0 
การทําเหมืองแรและเหมอืงหิน 821  789  636  764  0.2 -2.4 
การผลิต 213,696  225,002  229,441  239,421  65.4 3.9 
การไฟฟา กาซ และระบบปรับอากาศ 8,262  8,607  8,204  8,345  2.3 0.3 
การจัดหาน้าํ การจัดการ และการบาํบัดน้ําเสีย ของเสีย
และส่ิงปฏิกูล 

1,991 2,113 2,032 2,233 0.6 3.9 

การกอสราง 6,721  5,513  6,813  7,312  2.0 2.8 
การขายสงและการขายปลีก การซอมยานยนตและ
จักรยานยนต 

37,703 41,079 43,157 49,190 13.4 9.3 

การขนสงและสถานที่เกบ็สินคา 3,746  5,401  4,667  5,197  1.4 11.5 
ที่พักแรมและบริการดานอาหาร 547  581  643  685  0.2 7.8 
ขอมูลขาวสารและการส่ือสาร 1,974  2,200  2,253  2,407  0.7 6.8 
กิจกรรมทางการเงินและการประกันภัย 5,993  6,833  7,741  8,510  2.3 12.4 
กิจกรรมอสังหาริมทรัพย 3,035  5,066  6,177  5,778  1.6 23.9 
กิจกรรมทางวิชาชีพ วิทยาศาสตร และเทคนิค 927  932  815  684  0.2 -9.6 
กิจกรรมการบริหารและการบริการสนับสนุน 2,048  2,211  2,282  2,537  0.7 7.4 
การบริหารราชการ การปองกันประเทศ และการ
ประกันสังคมภาคบังคับ 

4,064 3,838  4,064 4,352 1.2 2.3 

การศึกษา 1,567  1,705  1,593  1,654  0.5 1.8 
กิจกรรมดานสุขภาพและงานสังคมสงเคราะห 3,880  4,081  4,341  4,568  1.2 5.6 
ศิลปะ ความบันเทิง และนันทนาการ 121  124  241  555  0.2 66.0 
กิจกรรมบริการดานอื่นๆ 1,269  1,242  1,338  1,503  0.4 5.8 
ผลิตภัณฑจังหวดั (Gross Provincial Product) 316,497  337,018  344,897  366,207  100.00 5.0 
ผลิตภัณฑจังหวดัเฉลี่ยตอคน (Per Capita GPP Baht) 343,513 361,083 364,718 382,679 - 3.6 
ประชากร (1,000 คน) 921 933 946 957 - 1.2 

ท่ีมา : สํานักงานคณะกรรมการพัฒนาการเศรษฐกิจและสังคมแหงชาต ิ
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แผนภูมิ 1 เปรียบเทียบ GPP ภาคเกษตรและนอกภาคเกษตร ป 2556– 2559 

 

แผนภูมิ 2  5 อันดับสาขาการผลิตท่ีมีอัตราการขยายตัวเฉล่ียสูงท่ีสุด ป 2559 
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1.3 ดัชนีราคาผูบริโภค 

         ดัชนีราคาผูบริโภคของจังหวัดสมุทรสาครเดือนมิถุนายน 2562 เทากับ 102.94 สําหรับเดือน
พฤษภาคม 2562 เทากับ 103.31 
        การเปลี่ยนแปลงดัชนีราคาผูบริโภคของจังหวัดสมุทรสาครเดือนมิถุนายน 2562 เม่ือเทียบกับ 
เดือนมิถุนายน 2561 ลดลงรอยละ 0.6 
  ถาพิจารณาเทียบกับเดือนมิถุนายน 2561 ลดลงรอยละ 0.1 สําหรับหมวดอาหารและเครื่องดื่มไมมี
แอลกอฮอลสูงข้ึนรอยละ 0.3 หมวดอ่ืน ๆ ไมใชอาหารและเครื่องดื่ม ลดลงรอยละ 0.2 ดัชนีราคาผูบริโภค
พ้ืนฐาน ลดลงรอยละ 0.2 
  

ตาราง 4 ดัชนีราคาผูบริโภคจังหวัดสมุทรสาคร เดือนมิถุนายน ป 2562 (2558=100) 

หมวด 
สัดสวน
น้ําหนัก 
ปฐาน 

ดัชน ี อัตราการเปลี่ยนแปลง 

พค.62 เม.ย.62 พค.61 
มค.ถึง 
พค.62 

พค.62/ 
เมย.62 

พค.62/ 
พค.61 

มค.62-พ.ค.62/ 
มค.61-พค.61 

 รวมทุกรายการ  100.00 101.6 101.1 101.3 100.8 0.5 0.3 0.0 

   หมวดอาหารและเคร่ืองด่ืม  41.77 102.2 101.0 101.0 100.8 1.2 0.4 -1.0 

     ขาว แปงและผลิตภณัฑจากแปง  3.38 94.1 95.7 95.7 95.1 -1.7 1.8 3.5 

     เน้ือสัตว เปดไก และสตัวนํ้า  8.76 108.7 109.1 109.1 108.8 -0.4 0.2 1.4 

     ไขและผลติภณัฑนม  1.31 99.8 99.4 99.4 100.0 0.4 0.4 -1.4 

     ผักและผลไม  5.83 99.2 89.4 89.4 88.3 11.0 11.0 -10.6 

     เครื่องประกอบอาหาร  2.51 102.6 103.0 104.0 103.5 -0.4 -1.3 -1.2 

     เครื่องดื่มไมมีแอลกอฮอล  1.43 100.2 100.7 99.3 100.7 -0.5 0.9 1.4 

     อาหารบรโิภค-ในบาน  8.59 103.9 103.9 103.9 103.9 0.0 0.0 0.0 

     อาหารบรโิภค-นอกบาน  9.95 99.5 99.5 99.5 99.5 0.0 0.0 0.0 

   หมวดอ่ืน ๆ ไมใชอาหาร และเคร่ืองด่ืม  58.23 101.0 101.0 100.8 100.7 0.0 0.2 0.7 

     หมวดเครื่องนุงหมและรองเทา  2.20 108.5 108.5 108.5 108.5 0.0 0.1 3.2 

     หมวดเคหสถาน  22.32 97.4 97.4 97.3 97.4 0.0 0.1 0.6 

     หมวดการตรวจรักษาและบรกิารสวน
บุคคล  

5.35 107.7 107.8 105.4 107.7 -0.1 2.2 4.0 

     หมวดพาหนะ การขนสง และการสื่อสาร  19.59 101.1 101.1 101.1 100.2 0.0 -0.2 -0.1 

     หมวดการบันเทิงการอานและการศึกษา
และการศาสนา  

6.24 100.4 100.4 100.3 100.4 0.0 0.0 0.2 

     หมวดยาสูบและเครื่องดื่มมีแอลกอฮอล  2.54 116.1 116.1 116.1 116.1 0.0 0.0 0.0 

   ดัชนีราคาผูบริโภคพ้ืนฐาน  71.72 101.6 101.6 101.4 101.3 0.0 0.2 0.6 

     กลุมอาหารสดและพลังงาน  28.28 101.7 99.9 101.1 98.9 1.8 0.6 -1.5 

      -  อาหารสด  19.28 102.4 99.7 101.4 99.2 2.7 1.0 -2.1 

      -  พลังงาน  9.00 99.8 99.8   100.1 97.8 0.0 -0.3 -0.3 

ท่ีมา : สํานักงานดัชนีเศรษฐกิจการคา  
หมายเหตุ : ดัชนีราคาผูบริโภคพื้นฐาน คือ ดัชนีราคาผูบริโภคชุดทั่วไปที่หกัรายการสินคากลุมอาหารสดและสินคากลุมพลังงาน 
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แผนภูมิ 3 เปรียบเทียบดัชนีราคาผูบริโภคจังหวัดสมุทรสาคร เดือนมิถุนายน ป 2562 (2558=100) 

 

 

1.4. ภาวะการลงทุน 

 1) การจดทะเบียนนิติบุคคลตั้งใหม 

 ขอมูล ณ วันท่ี 30 มิถุนายน 2562 จังหวัดสมุทรสาครมีการจดทะเบียนของนิติบุคคลรวม
จํานวนท้ังสิ้น 3,934  แหง เงินทุน 198,127.39 ลานบาท สําหรับในไตรมาส 2 ป 2562 มีการจดทะเบียนนิติ
บุคคลตั้งใหมท้ังสิ้น 341  แหง ทุนจดทะเบียน 1,781.92 ลานบาท จําแนกเปนบริษัทจํากัดจํานวน 279 แหง  
ทุนจดทะเบียน 737.03 ลานบาท และหางหุนสวนจํากัด 61 แหง ทุนจดทะเบียน 44.89 ลานบาท  
 

ตาราง 5  เปรียบเทียบการจดทะเบียนของนิติบุคคลจังหวัดสมุทรสาคร  

จดทะเบยีน 
ไตรมาส 4/2561 ไตรมาส 1/2562 ไตรมาส 2/2562 ทั้งหมดถึง 30 มิ.ย. 62 

จํานวน
(แหง) 

เงินทุน 
(ลานบาท) 

จํานวน
(แหง) 

เงินทุน
(ลานบาท) 

จํานวน
(แหง) 

เงินทุน
(ลานบาท) 

จํานวน
(แหง) 

เงินทุน(ลานบาท) 

บริษัทจํากัด 256 564.85 343 620.25 279 737.03 1,139 176,863.10 

หางหุนสวนจาํกัด 50 56.65 70 57.50 61 44.89 2,760 4,507.13 

หางหุนสวนสามัญนิติบุคคล 0 0.00 0 0.00 0 0.00 6 10.40 

บริษัทมหาชนจาํกัด 1 60.00 0 0.00 1 1,000.00 29 16,746.76 

รวม 307 681.50 413 677.75 341 1,781.92 3,934 198,127.39 

ท่ีมา : สํานักงานพัฒนาธุรกิจการคาจังหวัดสมุทรสาคร 

สําหรับประเภทอุตสาหกรรมท่ีมีการจดทะเบียนนิติบุคคลตั้งใหมมากท่ีสุดในไตรมาส 2 ป 2562  

คือ การขายสง การขายปลีก การซอมแซมยานยนต จักรยานยนต ของใชสวนบุคคลและของใชในครัวเรือน  

159 แหง (รอยละ 46.62) รองลงมาไดแก การผลิต 74 แหง (รอยละ 21.70) การกอสราง 33 แหง

(รอยละ 9 .68 )  และกิจกรรมวิชาชีพวิทยาศาสตรและกิจกรรมทางวิชาการ 18 แหง (รอยละ 5.28) 
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ตามลําดับ เม่ือพิจารณาประเภทอุตสาหกรรมที่มีทุนจดทะเบียนมากท่ีสุด ไดแก การผลิต มีทุนจดทะเบียน

ท้ังสิ้น 1,169.14 ลานบาท เปนทุนจดทะเบียนของบริษัทจํากัดจํานวน 157.90 ลานบาท และทุนจดทะเบียน

ของหางหุนสวนจํากัดจํานวน 11.24 ลานบาท รายละเอียดตามตาราง 6 

ตาราง 6 ตารางการจดทะเบียนนิติบุคคลตั้งใหมจังหวัดสมุทรสาคร ไตรมาส 2 ป 2562 

อุตสาหกรรม 
บริษัทจํากัด หางหุนสวนจํากัด 

หางหุนสวนสามญั
นิติบุคคล 

บริษัทมหาชน
จํากัด 

รวม 

แหง ลานบาท แหง ลานบาท แหง ลานบาท แหง 
ลาน
บาท 

แหง ลานบาท 

เกษตรกรรม การปาไม และการประมง 0 0 
- 
 

- 0 - - - 0 0.00 

การทําเหมืองแรและเหมืองหิน 1 1 - - 0 - - - 1 1.00 
การผลิต 58 157.90 15 11.24 0 - 1 1,000 74 1,169.14 
การไฟฟา  กาซไอน้ํา และระบบการปรับอากาศ 0 0.00 0 - 0 - - - 0 0.00 
การจัดหาน้าํ การจัดการน้ําเสีย และของเสียรวมถึง
กิจกรรมที่เกี่ยวของ 

1 1.00 0 - 0 - - - 1 1.00 

การกอสราง 30 50.50 3 1.20 0 - - - 33 51.70 
การขายสง  การขายปลีก  การซอมแซมยานยนต  
จักรยานยนต 

132 387.73 27    20.70 0 - 0 0 159 408.43 

การขนสง  สถานที่เก็บสินคา 9 17.40 4 4.00 0 - - - 13 21.40 
ที่พักแรมและบริการดานอาหาร 8 13.20 2 1.50 0 -    - - 10 14.70 

ขอมูลขาวสารและการส่ือสาร 3 3.00 0 - 0 - - - 3 3.00 

กิจกรรมทางการเงิน และการประกันภยั 3 37.00 1 1.00 0 - - - 4 38.00 
กิจกรรมเกี่ยวกับอสังหาริมทรัพย  6 27.00 0 0 0 - - - 6 27.00 
กิจกรรมวิชาชีพวิทยาศาสตรและกิจกรรมทาง
วิชาการ 

15 23.30 3 2.00 0 - - - 18 25.30 

กิจกรรมการบริหารและบริการสนับสนนุ 6 11.00 5 2.75 0 - - - 11 13.75 
การบริหารราชการและการปองกันประเทศ  และ
การประกันสังคมภาคบังคับ 

0 0 0 - 0 - - - 0 0.00 

การศึกษา 2 2.00 0 - 0 - - - 2 2.00 
การบริการดานสุขภาพและงานสังคมสงเคราะห 3 3.00 1 0.50 0 - - - 4 3.50 
ศิลปะ ความบันเทิงและนันทนาการ 0 0.00 0 0.00 0 - - - 0 0.00 
กิจกรรมการบริการดานอื่น ๆ 2 2.00 0 0.00 0  - - 2 2.00 
กิจกรรมการจางงานในครัวเรือน กิจกรรมการผลิต
สินคาและบริการที่ทําขึ้นเอง เพื่อใชในครัวเรือน ซ่ึง
ไมสามารถจําแนก กจิกรรมไดอยางชัดเจน 

0 0.00 0 0.00 0 - - - 0 0 

กิจกรรมขององคการระหวางประเทศและภาคี
สมาชิก 

0 0.00 0 0.00 0 - - - 0 0 

รวม 279 737.03 61 44.89 0 - 1 1000 341 1,781.92 

ท่ีมา : สํานักงานพัฒนาธุรกิจการคาจังหวัดสมุทรสาคร 

 
 
 
 
 



รายงานสถานการณแรงงานจังหวัดสมุทรสาคร ไตรมาส 2 ป 2562 

 

 

 
 

13 

2) การจดทะเบียนตั้งโรงงานใหม 
 

ขอมูล ณ 30 มิ.ย. 2562 จังหวัดสมุทรสาครมีการจดทะเบียนโรงงานรวมจํานวนท้ังสิ้น 
6,390 ราย เงินลงทุน 288,549.53 ลานบาท สําหรับในไตรมาส 1 ป 2562 มีการจดทะเบียนตั้งโรงงานใหม
จํานวน 84 ราย เงินลงทุน 2,268.13 ลานบาท โดยการจดทะเบียนตั้งโรงงานใหมในไตรมาสนี้ลดลงจาก 
ไตรมาสท่ีแลว (ไตรมาส 4/2561 จํานวน 97 โรง) คิดเปนสัดสวนลดลงรอยละ 13.40 และลดลงจากไตรมาส
เดียวกันของปท่ีผานมา (ไตรมาส 1/2561) จํานวน 107 โรง) คิดเปนสัดสวนลดลงรอยละ 21.49 ในสวน
โรงงานท่ีเลิกกิจการไตรมาสนี้มีจํานวน 44 โรง เงินทุน 986.35 ลานบาท รายละเอียดตามตาราง 7 
 

ตาราง 7 เปรียบเทียบการจดทะเบียนตั้งโรงงานและเลิกกิจการของจังหวัดสมุทรสาคร 
 

ไตรมาส 
จดทะเบียน เลิกกิจการ 

จํานวน (โรง) 
เงินทุน 

(ลานบาท) 
จํานวน (โรง) 

เงินทุน 
(ลานบาท) 

ไตรมาส 1/2561 (ม.ค.-ม.ีค. 61) 107 2,991.00 15 442.00 

ไตรมาส 4/2561 (ต.ค.-ธ.ค.61) 97 7,419 48 858 

ไตรมาส 1/2562 (ม.ค.-ม.ีค.62) 84 2,268.13 44 986.35 

จํานวนสะสมท้ังสิ้น ณ 31 มี.ค. 62 6,390 288,549.53 329,848 - 

ที่มา : สํานักงานอุตสาหกรรมจังหวัดสมุทรสาคร 
 

หากพิจารณาประเภทอุตสาหกรรมท่ีมีการจดทะเบียนโรงงานมากท่ีสุดในไตรมาสนี้ คือ 
อุตสาหกรรมพลาสติก 20 ราย เงินลงทุน 355.87 ลานบาท รองลงมาไดแก  อุตสาหกรรมอาหาร 
12 ราย เงินลงทุน 495.64 ลานบาท ตามลําดับ 
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ตาราง 8 การจดทะเบียนโรงงานอุตสาหกรรมท่ีประกอบกิจการใหมของจังหวัดสมุทรสาคร  

จําแนกตามหมวดอุตสาหกรรม ไตรมาส 2 ป 2562 

ท่ี รายการ 
ไตรมาส 1 ป 2562 จํานวนสะสมท้ังสิ้น ณ 31 ม.ีค. 62 

จํานวน 
เงินทุน 

(ลานบาท) 
คนงาน 
(คน) 

จํานวน 
เงินทุน 

(ลานาท) 
คนงาน 
(คน) 

1 อุตสาหกรรมการเกษตร 1 3.10 15 47 4,787.19 2,111 

2 อุตสาหกรรมอาหาร 12 495.64 968 845 63,678.98 85,702 

3 อุตสาหกรรมเครื่องดื่ม 1 19.00 9 23 999.25 582 

4 อุตสาหกรรมสิ่งทอ 3 58.00 90 459 26,996.00 39,673 

5 อุตสาหกรรมเครื่องแตงกาย - - - 73 3,107.80 17,866 

6 อุตสาหกรรมเครื่องหนัง - - - 45 654.56 2,696 

7 อุตสาหกรรมไมและผลิตภณัฑจากไม 2 5.80 28 123 1,769.82 3,097 

8 อุตสาหกรรมเฟอรนิเจอรและเครือ่งเรือน - - - 108 5,736.18 5,554 

9 อุตสาหกรรมกระดาษและผลติภณัฑจาก
กระดาษ 

4 130.39 87 138 7,839.72 6,340 

10 อุตสาหกรรมสิ่งพิมพ 1 44.00 32 159 4,365.01 4,302 

11 อุตสาหกรรมเคม ี 1 8.00 15 256 9,628.62 6,815 

12 อุตสาหกรรมปโตรเคมีและผลติภณัฑ - - - 26 2,252.47 1,341 

13 อุตสาหกรรมยาง 2 11.50 17 170 10,485.47 13,119 

14 อุตสาหกรรมพลาสติก 20 355.87 508 1,089 34,249.94 39,892 

15 อุตสาหกรรมอโลหะ 3 72.00 41 126 3,768.70 4,288 

16 อุตสาหกรรมโลหะ 2 423.01 393 326 9,572.11 9,735 

17 อุตสาหกรรมผลติภณัฑโลหะ 12 240.75 304 1,125 32,048.47 34,307 

18 อุตสาหกรรมเครือ่งจักรกล 1 35.00 10 161 4,726.46 8,397 

19 อุตสาหกรรมไฟฟา 7 111.85 127 237 7,826.81 9,343 

20 อุตสาหกรรมขนสง 2 36.62 21 278 8,026.12 9,713 

21 อุตสาหกรรมอ่ืนๆ 10 217.60 546 576 46,029.85 24,975 

  รวม 84 2,268.13 3,211 6,390 289,549.53 329,848 
ที่มา : สํานักงานอุตสาหกรรมจังหวัดสมุทรสาคร 

 
 
 
 
 
 

f  
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ดัชนีช้ีวัดภาวะแรงงานจังหวัดสมุทรสาคร 
 

ดัชนีชี้วัดดานแรงงานเปนดัชนีท่ีแสดงถึงสถานการณดานแรงงานในชวงเวลาใดเวลาหนึ่ง การติดตาม

การเปลี่ยนแปลงของดัชนีชี้วัดดานแรงงานจะทําใหทราบถึงความเคลื่อนไหวของสถานการณ เพ่ือใชเปน

เครื่องมือในการศึกษา วิเคราะหถึงสาเหตุ และปญหา รวมถึงปจจัยตางๆ ท่ีมีผลใหดัชนีแตละตัวเปลี่ยนแปลง

ไป สถานการณแรงงานไตรมาส 2/2562 (เมษายน-มิถุนายน 2562) ฉบับนี้จึงขอนําเสนอดัชนีชี้วัดภาวะ

แรงงานตามลําดับ ดังนี้ 

1)  อัตราการมีสวนรวมในกําลังแรงงาน 

อัตราการมีสวนรวมในกําลังแรงงานเปนดัชนีชี้วัดท่ีแสดงใหเห็นถึงสภาพกําลังแรงงานในตลาดแรงงาน 
เม่ือเทียบกับประชากรวัยแรงงานท้ังหมด โดยคํานวณจากกําลังแรงงานรวมซ่ึงประกอบดวย 3 กลุม  
คือ กลุมผูมีงานทํา ผูวางงานและผูรอฤดูกาล เปรียบเทียบกับประชากรท่ีมีอายุ 15 ปข้ึนไป ไตรมาส 2/2562  
อัตราการมีสวนรวมในกําลังแรงงานจังหวัดสมุทรสาคร มีอัตรารอยละ 80.06 ซ่ึงมีสัดสวนเทาเดิมจากไตรมาสท่ี
แลวท่ีมีอัตรารอยละ 80.06 และเม่ือเทียบกับไตรมาสเดียวกันของปท่ีผานมาท่ีมีอัตรา รอยละ 78.74 พบวา มี
สัดสวนลดลงรอยละ 1.32 

แผนภูมิ  1  อัตราการมีสวนรวมในกําลังแรงงานจังหวัดสมุทรสาคร 
 

 
 

 

 

 

 

หมายเหตุ : อัตราการมีสวนรวมในกําลังแรงงานในจังหวัด   =         กําลังแรงงานในจังหวดั x 100 
                                                                                      ประชากรที่มีอาย ุ15 ปขึน้ไปในจังหวัด 



รายงานสถานการณแรงงานจังหวัดสมุทรสาคร ไตรมาส 2 ป 2562 

 

 

 16 

หมายเหตุ : อัตราการจางงานใน/นอกภาคเกษตรในจังหวัด = ผูมีงานทําใน/นอกภาคเกษตรในจังหวัด x 100 

                                                                                             ผูมีงานทําในจังหวัด 

2) อัตราการจางงาน 

อัตราการจางงานตอกําลังแรงงานเปนดัชนีชี้วัดท่ีแสดงใหเห็นภาวะการจางงานในตลาดแรงงานวามี

สัดสวนมากนอยเพียงใด ขอมูล ณ ไตรมาส 2/2562 สําหรับอัตราการจางงานในภาคเกษตรของจังหวัด

สมุทรสาคร พบวา อัตราการจางงานในภาคเกษตรมีอัตรารอยละ 8.10 มีสัดสวนเพ่ิมข้ึนรอยละ 20.00  

เม่ือเทียบกับไตรมาสท่ีแลวท่ีมีอัตรารอยละ 6.15 และเม่ือเทียบกับไตรมาสเดียวกันของปท่ีผานมา พบวามี

สัดสวนเพ่ิมข้ึนรอยละ 1.32 โดยไตรมาส 2/2561 มีอัตรารอยละ 3.97 สวนอัตราการจางงานนอกภาคเกษตร

ในไตรมาส 2/2562 มีอัตรารอยละ 93.85 พบวา มีสัดสวนลดลงรอยละ 0.18 จากไตรมาสท่ีแลวท่ีมีอัตรารอยละ 

94.71 และเม่ือเทียบกับไตรมาสเดียวกันของปท่ีผานมาท่ีมีอัตรารอยละ 93.67 พบวา มีสัดสวนเพ่ิมข้ึนรอยละ 1.04 

แผนภูมิ  2  อัตราการจางงานใน/นอกภาคเกษตรจังหวัดสมุทรสาคร 
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เม่ือพิจารณาอัตราการจางงานเฉพาะในสวนภาคอุตสาหกรรมการผลิต โดยคํานวณจากจํานวนผูมีงาน

ทําในภาคอุตสาหกรรมการผลิตเปรียบเทียบกับจํานวนผูมีงานทําท้ังหมดจะพบวา อัตราการจางงานใน

อุตสาหกรรมการผลิตไตรมาส 2/2562 มีอัตรารอยละ57.53 ซ่ึงมีสัดสวนลดลงรอยละ 2.92 จากไตรมาส 

ท่ีแลวท่ีมีอัตรารอยละ 60.45 

 

แผนภูมิ  3  อัตราการจางงานในอุตสาหกรรมการผลิตจังหวัดสมุทรสาคร 
  

 

 
 
 
 

    หมายเหตุ  : อัตราการจางงานในอุตสาหกรรมการผลิตจังหวัด =       ผูมีงานทําในภาคอุตสาหกรรมการผลิตจังหวดั x 100 

 ผูมีงานทําในจังหวัด 
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3) อัตราการวางงาน 

การศึกษาอัตราการวางงานในปท่ีผานมา จะพบวา อัตราการวางงานของจังหวัดสมุทรสาคร แตละไตรมาส
จะปรับตัวสูงข้ึนและลดลงตามปจจัยในเรื่องฤดูกาลและการเขาสูตลาดแรงงานของผูสําเร็จการศึกษา  
ไตรมาส 2/2562  นี้ อัตราการวางงานในจังหวัดสมุทรสาคร มีอัตรารอยละ 0.63 มีสัดสวนเทาเดิมจาก 
ไตรมาสท่ีแลวท่ีมีอัตรารอยละ 0.63   

แผนภูมิ  4 อัตราการวางงานจังหวัดสมุทรสาคร  
 

 

 

 

 

 

  

                                    หมายเหตุ  :  อัตราการวางงานในจังหวัด   =       จํานวนผูไมมีงานทาํจังหวดั x 100 

                                                                    กาํลังแรงงานในจังหวัด 
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4) อัตราการเปล่ียนแปลงของจํานวนผูประกันตนในระบบประกันสังคม (มาตรา 33) ผูประกันตนท่ีขอรับ

ประโยชนทดแทนกรณีวางงาน และอัตราการเลิกจางลูกจางในระบบประกันสังคมมาตรา 33 

 จํานวนผูประกันตนมาตรา 33 ของสํานักงานประกันสังคมจังหวัดสมุทรสาคร ไตรมาส 2/2562  

มีจํานวน 456,284 คน อัตราการเปลี่ยนแปลงของจํานวนผูประกันตน (มาตรา 33) (YOY) ลดลงรอยละ 3.80   

นอยกวาไตรมาสกอนท่ีรอยละ 16.19 จํานวนผูประกันตนท่ีขอรับประโยชนทดแทนกรณีวางงาน 11,586 คน  

(ใชขอมูลจากสํานักงานประกันสังคมจังหวัด) อัตราเปลี่ยนแปลงของผูประกันตนท่ีขอรับประโยชนทดแทนกรณี

วางงาน (YOY) มีอัตรารอยละ 14.77 เพ่ิมข้ึนเม่ือเทียบกับไตรมาสกอนซ่ึงมีอัตรารอยละ -5.66  

สําหรับจํานวนผูประกันตนท่ีข้ึนทะเบียนขอรับประโยชนทดแทนกรณีเลิกจาง (ใชขอมูลจากสํานักงาน

ประกันสังคมจังหวัด) อัตราเปลี่ยนแปลงของผูประกันตนท่ีข้ึนทะเบียนขอรับประโยชนทดแทนกรณีเลิกจาง

ลดลงรอยละ 35.10 เพ่ิมข้ึนจากไตรมาสกอนท่ีมีอัตราเปลี่ยนแปลงลดลง 62.48 

แผนภูมิ 5 อัตราการเปล่ียนแปลงของจํานวนผูประกันตนในระบบประกันสังคม (มาตรา 33) ผูประกันตน

ท่ีขอรับประโยชนทดแทนกรณีวางงาน และอัตราการเลิกจางลูกจางในระบบประกันสังคมมาตรา 33 
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5) อัตราการบรรจุงาน 

อัตราการบรรจุงานในแตละไตรมาสเปนดัชนีชี้วัดท่ีแสดงใหเห็นถึงการเคลื่อนไหวของภาวะดาน
แรงงาน  ซ่ึงสามารถศึกษาวิเคราะหกับจํานวนตําแหนงงานวาง และจํานวนผูสมัครงาน โดยเม่ือวิเคราะห
จํานวนการบรรจุงานท่ีสํานักงานจัดหางานจังหวัดสมุทรสาครดําเนินการเทียบกับจํานวนตําแหนงงานวางท่ีแจง
ผานสํานักงานจัดหางานฯ จะพบวา  อัตราการบรรจุงานตอตําแหนงงานวางไตรมาส 2/2562 อัตรารอยละ 
159.58 มีสัดสวนเพ่ิมข้ึนรอยละ 53.91 เม่ือเทียบกับไตรมาสท่ีแลว (ไตรมาส 1/2562 มีอัตรารอยละ 152.63) 
และมีสัดสวนเพ่ิมข้ึนรอยละ 67.17 เม่ือเทียบกับไตรมาสเดียวกันของปท่ีผานมา (ไตรมาส 1/2561 มีอัตรารอย
ละ 140.52)  

เม่ือศึกษาสัดสวนของผูบรรจุงานกับจํานวนผูสมัครงานในไตรมาสนี้มีอัตรารอยละ 88.37 พบวา  
มีสัดสวนลดลงรอยละ 53.42 เม่ือเทียบกับไตรมาสท่ีแลว (ไตรมาส 4/2561 มีอัตรารอยละ 149.52) และมี
สัดสวนเพ่ิมข้ึนรอยละ 26.15 เม่ือเทียบกับไตรมาสเดียวกันของปท่ีผานมา (ไตรมาส 1/2561 มีอัตรารอยละ
55.21) 

แผนภูมิ 6 อัตราการบรรจุงานตอผูสมัครงาน/ตําแหนงงานวางในจังหวัดสมุทรสาคร  
 

                   

 

 

 

 

 

 

 

 

หมายเหต ุ :   

1. อัตราการบรรจุงานตอผูสมัครงานจังหวัด.....        =            ผูไดรับการบรรจุงานในจงัหวัด  x  100                                                        
                                                                                    ผูสมัครงานในจังหวัด 

2. อัตราการบรรจุงานตอตําแหนงงานวางจังหวดั                =        ผูไดรับการบรรจุงานในจังหวัด  x  100 
                                                                                   ตําแหนงงานวางในจังหวัด 
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6) อัตราการไมปฏิบัติตามขอกฎหมายของสถานประกอบกิจการ 

อัตราการไมปฏิบัติตามขอกฎหมายคุมครองแรงงานของสถานประกอบกิจการตอจํานวนสถานประกอบ

กิจการท่ีการตรวจท้ังหมดในไตรมาส 2/2562 พบวา มีอัตรารอยละ 4.45 ท้ังนี้ สถานประกอบกิจการท่ีทําผิด

กฎหมายคุมครองแรงงาน เจาหนาท่ีไดใหคําแนะนําใหดําเนินการใหถูกตองตามขอกฎหมายแลว  

แผนภูมิ 7 อัตราการไมปฏิบัติตามขอกฎหมายของสถานประกอบการจังหวัดสมุทรสาคร 
 

 
 
 
 

หมายเหตุ  :  

อัตราการไมปฏิบัติตามขอกฎหมายคุมครองแรงงานของสถานประกอบการจังหวัด = 

จํานวนสถานประกอบการที่ทําผิดกฎหมายคุมครองแรงงานจังหวัด x  100 
จํานวนสถานประกอบการที่ผานการตรวจกฎหมายคุมครองแรงงานจังหวัด 

อัตราการไมปฏิบัติตามขอกฎหมายความปลอดภัยของสถานประกอบการจังหวัด- = 

จํานวนสถานประกอบการที่ทําผิดกฎหมายความปลอดภยัในจังหวัด  x 100 
  จํานวนสถานประกอบการที่ผานการตรวจกฎหมายความปลอดภยัจังหวัด 
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7) อัตราสถานประกอบการท่ีเขาสูระบบประกันสังคม 

ในส วน อัตราสถานประกอบการ ท่ี เข าสู ร ะบบประกันสั งคม โดยการ ศึกษาจากจํ านวน 
สถานประกอบการในระบบประกันสังคมของจังหวัดสมุทรสาคร เปรียบเทียบกับจํานวนสถานประกอบการ
ท้ังหมดของจังหวัดสมุทรสาคร  พบวา สัดสวนของสถานประกอบการท่ีเขาสูระบบประกันสังคมมีเปลี่ยนแปลง
จากไตรมาส 3/2561 - ไตรมาส 2/2562 ดังนี้  74.98 83.80 85.69 80.39 78.16 และ 96.79 ตามลําดับ 

 
แผนภูมิ 8 อัตราสถานประกอบการท่ีเขาสูระบบประกันสังคมในจังหวัดสมุทรสาคร 
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หมายเหตุ  :  อัตราแรงงานที่เปนผูประกันตนในจังหวดั   =       จาํนวนผูประกันตนมาตรา 33 , 39 , 40 ในจังหวดั x 100 

                                                                                            จํานวนผูมีงานทําในจังหวัด 

 

8) อัตราแรงงานท่ีเปนผูประกันตน 

 อัตราแรงงานท่ีเปนผูประกันตนคิดจากจํานวนผูประกันตนของกองทุนประกันสังคมตามมาตรา 33 , 

39 และ 40 ตอจํานวนผูมีงานทําของสํานักงานสถิติจังหวัดสมุทรสาคร พบวา อัตราแรงงานท่ีเปนผูประกันตน 

มีอัตรารอยละ 64.53 อัตราเปลี่ยนแปลงลดลงจากไตรมาสท่ีผานมารอยละ -11.62 และลดลงจากไตรมาส

เดียวกันของปท่ีผานมาท่ีมีอัตรารอยละ 76.33 อัตรารอยละ 11.8 สํานักงานประกันสังคมจังหวัดไดขยายความ

คุมครองไปสูกลุมผูใชแรงงานนอกระบบเพ่ือจูงใจใหผูใชแรงงานเขามาอยูในระบบประกันสังคมอันจะนําไปสู

การมีหลักประกันความม่ันคงในชีวิตเพ่ิมมากข้ึน  

 

แผนภูมิ 9 อัตราแรงงานท่ีเปนผูประกันตนจังหวัดสมุทรสาคร 
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สถานการณแรงงานจังหวัดสมุทรสาคร 
 สถานการณแรงงานจังหวัดสมุทรสาครไตรมาส 2 ป 2562 ชวงเดือนเมษายน – มิถุนายน 2562  
ขอนําเสนอขอมูลในประเด็นตาง ๆ ตามลําดับคือ 1) กําลังแรงงาน การมีงานทํา  การวางงาน 2) การสงเสริม
การมีงานทํา 3) การพัฒนาศักยภาพแรงงาน 4) การคุมครองแรงงานและสวัสดิการ 5) การประกันสังคม  
6) ปญหาดานแรงงานท่ีสําคัญ 7) ผลการดําเนินงานท่ีสําคัญตามนโยบายรัฐบาล/นโยบายกระทรวงแรงงาน 
 

1. กําลังแรงงาน การมีงานทํา และการวางงาน 

1) กําลังแรงงาน 
   สํานักงานสถิติจังหวัดสมุทรสาครไดดําเนินการสํารวจและประมวลผลเปนรายไตรมาส  

สําหรับไตรมาส 2 ป 2562 จังหวัดสมุทรสาครมีประชากรท่ีมีอายุ 15 ปข้ึนไปรวมท้ังสิ้นจํานวน 883,705 คน 
เปนผูอยูในกําลังแรงงานจํานวน 707,496 คน หรือรอยละ 80.60 ของประชากรท่ีมีอายุ 15 ปข้ึนไปและผูไม
อยูในกําลังแรงงานจํานวน 176,209 คน (รอยละ 19.93) ในจํานวนกลุมผูท่ีอยูในกําลังแรงงานนั้น จําแนกเปน
ผูมีงานทําจํานวน 703,036 คน หรือ (รอยละ 79.55) ของผูอยูในกําลังแรงงาน มีผูวางงานจํานวน 4,460 คน 
(รอยละ 0.50) 
 

แผนภูมิ 1 ภาวะการทํางานของประชาชน จังหวัดสมุทรสาคร 
ไตรมาส 2/2562 

 

 

 

 

 

 

 

 

 

 

ที่มา: สํานักงานสถิติจังหวัดสมุทรสาคร 
 
 
 
 
 
 

ผูอยูในวัยทํางาน(อายุ 15 ปข้ึนไป) 
883,705 คน 

ผูอยูในกําลังแรงงาน 

707,496 คน 
ผูไมอยูในกําลังแรงงาน 

176,209 คน 

ผูมีงานทํา  703,036 คน 

ผูรอฤดูกาล  -  คน 

ผูวางงาน  4,460 คน 

ทํางานบาน  57.958 คน 

เรียนหนังสือ 49,985 คน 

อ่ืนๆ  68,266 คน 



รายงานสถานการณแรงงานจังหวัดสมุทรสาคร ไตรมาส 2 ป 2562 

 

 
 25 

2) การมีงานทํา 

2.1) ผูมีงานทําจําแนกตามสถานภาพการทํางาน 

    ในไตรมาส 2/2562 มีกลุมผูมีงานทํามีจํานวนท้ังสิ้นจํานวน 708,925 คน แบงออกเปนกลุม
ตางๆ ตามสถานภาพการทํางานแลว พบวา ผูมีงานทําสวนใหญเปนกลุมลูกจางเอกชนมากท่ีสุด จํานวนรวม
ท้ังสิ้น 481,411 คน (รอยละ 67.90) รองลงมาไดแก กลุมผูทํางานสวนตัวจํานวน 118,004 คน (รอยละ 
16.64) กลุมผูชวยธุรกิจครอบครัวจํานวน 70,639 คน (รอยละ9.96) และลูกจางรัฐบาลจํานวน 27,077 คน 
(รอยละ 3.81) ตามลําดับ สวนผูมีงานทําท่ีมีสถานภาพเปนนายจางมีจํานวน 11,794 คน (รอยละ 1.66)  

แผนภูมิ 2 จํานวนผูทํางานจําแนกตามสถานภาพการทํางาน 
ไตรมาส 2/2562 

 
 

 

 

2.2) ผูมีงานทําจําแนกรายอุตสาหกรรม 

      จากขอมูลจํานวนผูมีงานทําจําแนกเปนรายอุตสาหกรรม พบวา ณ ไตรมาส 2/2562           
มีผูทํางานในภาคเกษตรรวมจํานวน 57,467 คน (คิดเปนรอยละ 8.10 ของผูมีงานทําท้ังหมด) ในขณะท่ีนอก
ภาคเกษตรนั้น มีผูทํางานท้ังสิ้นจํานวน 651,458 คน (รอยละ 91.89 ของผูมีงานทําท้ังหมด)  

          เม่ือพิจารณาจําแนกเปนรายสาขายอย พบวาสาขาท่ีมีผูทํางานมากท่ีสุดในไตรมาส 2/2562 
ไดแก สาขาการผลิต โดยมีผูทํางานรวมท้ังสิ้นจํานวน 407,890 คน (รอยละ 57.53 ของจํานวนผูมีงานทํา
ท้ังหมด) รองลงมาไดแก สาขาการขายสง การขายปลีก การซอมแซมยานยนต รถจักรยานยนตของใชสวน
บุคคล และของใชในครัวเรือน 81,356 คน (รอยละ 11.47) กิจการดานอสังหาริมทรัพย การใหเชา และ
กิจกรรมทางธุรกิจ 49,991 คน (รอยละ 7.05) โรงแรมและภัตตาคาร 40,219 คน และกอสราง 20,444 คน 
(รอยละ 2.88) ตามลําดับ  
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แผนภูมิ 3 จํานวนผูทํางานในภาคเกษตรและนอกภาคเกษตร 5 อันดับแรก 
ไตรมาส 2/2562 

 

 
 

 

 

2.3) ผูมีงานทําจําแนกตามอาชีพ 

     ในไตรมาส 2/2562 พบวา อาชีพท่ีมีผูทํางานมากท่ีสุด 5 อันดับแรก ไดแก  

1) อาชีพผูปฏิบัติการโรงงานและเครื่องจักร และผูปฏิบัติงานดานการประกอบ จํานวน 212,091 คน         
(รอยละ 29.91)  
2) อาชีพข้ันพ้ืนฐานตาง ๆ ในดานการขายและการใหบริการ จํานวน 130,024 คน (รอยละ 18.34)  
3) อาชีพผูปฏิบัติงานดานความสามารถทางฝมือ และ ธุรกิจอ่ืนๆท่ีเก่ียวของ จํานวน 111,414 คน           
(รอยละ15.71) 
4) อาชีพพนักงานบริการและพนักงานในรานคา และตลาด จํานวน 98,501 คน (รอยละ13.89)  
5) ผูปฏิบัติงานท่ีมีฝมือในดานเกษตร จํานวน 45,987 คน (รอยละ 6.48) ตามลําดับ      
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แผนภูมิ 4 อาชีพท่ีมีผูทํางานอยูมากท่ีสุด 5 อันดับไตรมาส 2/2562 
 

 

 

 

2.4) ผูมีงานทําจําแนกตามระดับการศึกษา 

เม่ือพิจารณากลุมผูมีงานทําจําแนกออกตามระดับการศึกษาท่ีจบในไตรมาส 2/2562 พบวา 
แรงงานสวนใหญมีการศึกษาในระดับมัธยมศึกษาตอนตนจํานวน 152,952 คน (รอยละ21.57 ของ
จํานวนผูมีงานทําท้ังหมด) รองลงมาไดแกแรงงานท่ีมีการศึกษาอ่ืนๆ จํานวน 121,735 คน (รอยละ 
17.17) ระดับประถมศึกษาจํานวน 121,231(รอยละ 17.10) ระดับมหาวิทยาลัย จํานวน 107,924 
คน (รอยละ 15.22) มัธยมศึกษาตอนปลาย จํานวน 82,551 คน (รอยละ 11.64 ตามลําดับ 

แผนภูมิ 5 สัดสวนของผูทํางานจําแนกตามระดับการศึกษา ไตรมาส 2/2562 
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3) การวางงาน 

ในไตรมาส 2/2562 จังหวัดสมุทรสาครมีผูวางงานจํานวนท้ังสิ้น 3,404 ราย คิดเปนอัตราการ
วางงานเทากับรอยละ 0.5 ของกําลังแรงงานท้ังหมด ท้ังนี้เม่ือพิจารณากลุมผูวางงานจําแนกตามเพศ
แลวพบวาเพศหญิงมีอัตราการวางงานนอยกวาเพศชาย  

 

แผนภูมิ 6 เปรียบเทียบอัตราการวางงาน จําแนกตามเพศ  
ไตรมาส 2/2562 

                     
 

4) แรงงานนอกระบบ 

   สําหรับกลุมแรงงานนอกระบบนั้น จากขอมูลของสํานักงานสถิติจังหวัดสมุทรสาครในป 2561 
พบวา มีผูมีงานทําซ่ึงเปนแรงงานนอกระบบ (นอกระบบประกันสังคม) จํานวนท้ังสิ้น 160,818 คน โดยสาขาท่ี
มีจํานวนแรงงานนอกระบบสูงสุด 3 อันดับแรก ไดแก สาขาขายสง การขายปลีก มีจํานวน 45,676 คน  
(รอยละ 28.40 ของแรงงานนอกระบบท้ังหมด) รองลงมาไดแก สาขาเกษตรกรรม จํานวน 40,417 คน (รอย
ละ 25.13) และสาขาโรงแรม และภัตตาคาร จํานวน 26,072 คน (รอยละ 16.21 ตามลําดับ  

แผนภูมิ 7 5 อันดับสาขาการผลิตท่ีมีแรงงานนอกระบบทํางานอยูมากท่ีสุดในป 2561 
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เม่ือพิจารณาแรงงานนอกระบบจําแนกตามอาชีพ พบวาอาชีพท่ีมีแรงงานนอกระบบทํางานอยูมาก
ท่ีสุด 3 อันดับแรก ไดแก อาชีพพนักงานบริการและพนักงานในรานคา และตลาด จํานวน 67,401 คน  
(รอยละ 41.91 ของแรงงานนอกระบบท้ังหมด) รองลงมาไดแก อาชีพผูปฏิบัติงานดานความสามารถทางฝมือ 
ดานเกษตร จํานวน 36,749 คน (รอยละ 22.85) และอาชีพผูปฏิบัติการโรงงานและเครื่องจักร และ
ผูปฏิบัติงานดานการประกอบ จํานวน 16,287 คน (รอยละ 10.13) ตามลําดับ  

 

แผนภูมิ 8 5 อันดับสาขาอาชีพท่ีมีแรงงานนอกระบบทํางานอยูมากท่ีสุดในป 2561 
ของจังหวัดสมุทรสาคร 

 

 

2. การจัดหางานและสงเสริมการมีงานทํา 

1) การจัดหางานในจังหวัด 

1.1) ตําแหนงงานวาง ผูสมัครงาน และการบรรจุงาน จําแนกตามเพศ 

ภารกิจการสงเสริมใหประชาชนมีงานทํา  เปนภารกิจหลักของกระทรวงแรงงาน                

ซ่ึงดําเนินการโดยสํานักงานจัดหางานจังหวัด เพ่ือสงเสริมการมีงานทํา มีรายไดท่ีเหมาะสม ลดปญหาการวางงาน 

และการขาดแคลนแรงงาน ในรูปแบบการจัดหางานท้ังในประเทศและตางประเทศ  โดยการจัดหางานในจังหวัด

สมุทรสาคร ในชวงไตรมาส 2 ป 2562 มีตําแหนงงานวางท่ีแจงผานสํานักงานจัดหางานจังหวัดสมุทรสาคร

จํานวน  1,573 อัตรา ในสวนของผูลงทะเบียนสมัครงานในไตรมาสนี้มีจํานวน 871 คน ขณะท่ีผูไดรับการบรรจุ

งานในไตรมาสนี้มีจํานวน 1,390 คน ตามลําดับ 
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แผนภูมิ 9 เปรียบเทียบตําแหนงงานวาง ผูลงทะเบียนสมัครงาน และการบรรจุงาน 
 

 
เม่ือเปรียบเทียบภาพรวมของการจัดหางานระหวางเพศชายและเพศหญิงในไตรมาส 2/2562 

โดยตําแหนงงานวางสําหรับเพศชายมี 406 อัตรา (รอยละ 25.81 ของตําแหนงงานวางท้ังหมด) ในขณะท่ีเพศ
หญิงมี 82 อัตรา (รอยละ 5.21) เทานั้น สวนไมระบุเพศมีจํานวนถึง 1,085 อัตรา (รอยละ 68.98)            
การท่ีตําแหนงงานวางมากกวาครึ่งไมไดระบุเพศแสดงใหเห็นวาสถานประกอบการหรือนายจาง พิจารณาเห็นวา     
งานโดยท่ัวไป ไมวาชายหรือหญิงก็สามารถทําไดเชนกัน หรือไมมีความแตกตางในเรื่องเพศในอีกประการหนึ่งนายจาง
พิจารณาเห็นวาการไมระบุเพศจะมีผลดีในดานโอกาสการคัดเลือกมากกวาการระบุเพศ 

เม่ือพิจารณาถึงจํานวนผูลงทะเบียนสมัครงานในไตรมาสนี้พบวาเพศหญิงมาลงทะเบียนสมัคร
งานมากกวาเพศชาย โดยเพศหญิง 499 คน (รอยละ 57.29) และเพศชาย 372 คน (รอยละ 42.71)  
สวนการบรรจุงานนั้นเพศหญิงมีสัดสวนการบรรจุมากกวาเพศชายซ่ึงสอดคลองกับจํานวนผูมาลงทะเบียน
สมัครงาน โดยเพศหญิงมีการบรรจุ  794 คน (รอยละ57.12)  ส วนเพศชายมีการบรรจุ  596 คน  
(รอยละ 42.87)  

 

แผนภูมิ 10 เปรียบเทียบตําแหนงงานวาง ผูลงทะเบียนสมัครงาน และการบรรจุงาน              
จําแนกตามเพศ ไตรมาส 2/2562 

 

 
 



รายงานสถานการณแรงงานจังหวัดสมุทรสาคร ไตรมาส 2 ป 2562 

 

 
 31 

  1.2) ตําแหนงงานวาง และการบรรจุงาน จําแนกตามอุตสาหกรรม 

เม่ือพิจารณาเปนรายอุตสาหกรรมแลว พบวา ในไตรมาส 2/2562 ตําแหนงงานวางในจังหวัด
สมุทรสาครเปนงานนอกภาคเกษตรกรรม รอยละ 100.00 โดยสาขาอุตสาหกรรมท่ีมีตําแหนงงานวางสูงสุด 
ไดแก สาขาการผลิต จํานวน 1,311 อัตรา (รอยละ94.31) รองลงมาไดแก โรงแรม และภัตตาคาร จํานวน 127 
(รอยละ 9.13) กิจกรรมดานบริการชุมชน สังคม และการบริการสวนบุคคลอ่ืนๆ จํานวน 40 อัตรา (รอยละ 
2.88) และการเปนสื่อกลางทางการเงิน จํานวน 24 อัตรา (รอยละ1.72) ตามลําดับ  

การบรรจุงาน พบวา สาขาอุตสาหกรรมท่ีมีการบรรจุงานมากท่ีสุดไดแกสาขาการผลิตจํานวน 
949 คน (รอยละ 68.27) รองลงมาไดแกสาขาสาขาการขายสง การขายปลีก การซอมแซมยานยนต ของใช
สวนบุคคล และของใชในครัวเรือน จํานวน 200 คน (รอยละ 14.38 ) และไมทราบ จํานวน 84 คน (รอยละ 
6.04) ตามลําดับ 

แผนภูมิ 11 เปรียบเทียบตําแหนงงานวาง และการบรรจุงาน ในภาคเกษตร 
และนอกภาคเกษตร ไตรมาส 2/2562 ของจังหวัดสมุทรสาคร 

 

1.3) ตําแหนงงานวาง ผูสมัครงาน และการบรรจุงาน จําแนกตามอาชีพ 

       ในไตรมาส 2/2562 สาขาอาชีพท่ีมีตําแหนงงานวางสูงสุด 3 อันดับแรก ไดแก 1) อาชีพงาน
พ้ืนฐาน ไดแก อาชีพท่ีเปนงานเรียบงายทําประจําหรือทําซํ้า ๆ ประกอบดวย อาชีพดานการขายและการ
ใหบริการตามทองถนนท่ีสาธารณะ เชน ผูจําหนายสินคา/อาหารตามทองถนน ผูสงเอกสาร ผูขนสัมภาระ 
รวมถึงแรงงานในดานเกษตร ประมง กอสราง การผลิต การขนสง ฯลฯ โดยมีตําแหนงงานวางจํานวน 818 
อัตรา (รอยละ 52.00 )  2) ผูปฏิบัติงานโดยใชฝมือในธุรกิจตางๆ จํานวน 186 อัตรา (รอยละ 11.82)            
3) ชางเทคนิคและผูปฏิบัติงานท่ีเก่ียวของจํานวน 156 อัตรา (รอยละ 9.91) 

      ในดานผูหางานนั้น พบวา มีผูลงทะเบียนสมัครงานสูงสุด 3 อันดับแรก ไดแก 1) สาขาอาชีพงาน
พ้ืนฐาน จํานวน 423 คน (รอยละ 48.56) 2) อาชีพเสมียน เจาหนาท่ีจํานวน 111 คน (รอยละ 12.74)         
3) ชางเทคนิคและผูปฏิบัติงานท่ีเก่ียวของ จํานวน 88 คน (รอยละ 10.10)  

     สวนการบรรจุงานมีความสอดคลองกับผูสมัครงานโดย 3 อันดับท้ังหมด เปนประเภทอาชีพ
เดียวกับผูสมัครงาน ไดแก 1) อาชีพงานพ้ืนฐาน จํานวน 582 คน (รอยละ 41.87) 2) เสมียนและเจาหนาท่ี 
199 อัตรา (รอยละ 14.31) 3) ชางเทคนิคและผูปฏิบัติงานท่ีเก่ียวของ จํานวน 191 อัตรา (รอยละ 13.74)  
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แผนภูมิ 12 เปรียบเทียบตําแหนงงานวาง ผูลงทะเบียนสมัครงาน บรรจุงาน จําแนกตามสาขาอาชีพ  
ไตรมาส 2/2562 

 

 
 

1.4) ตําแหนงงานวาง ผูสมัครงาน และการบรรจุงาน จําแนกตามวุฒิการศึกษา 

สําหรับตําแหนงงานวางตามระดับการศึกษาในไตรมาส 2/2562 พบวา ตําแหนงงานวางท่ี
ตองการมากท่ีสุดคือ ระดับมัธยมัธยมศึกษา จํานวน 669 อัตรา (รอยละ 42.53 รองลงมาไดแก 
ปวช.-ปวส/อนุปริญญา จํานวน 531 อัตรา (รอยละ 33.75) ระดับประถมศึกษาและต่ํากวา จํานวน 
256 อัตรา (รอยละ 16.27) แสดงใหเห็นวาตลาดแรงงานมีความตองการแรงงานในระดับต่ํากวา
ปริญญาตรี โดยเฉพาะมัธยมศึกษาท่ีมีความตองการสูงสุด   

สําหรับผูมาลงทะเบียนสมัครงานสวนใหญเปนแรงงานท่ีมีการศึกษาระดับมัธยมศึกษา  
จํานวน 469 คน (รอยละ 53.84 ) รองลงมาไดแกระดับปวช.-ปวส./อนุปริญญา จํานวน 236 อัตรา 
(รอยละ 27.09) และระดับประถมศึกษา จํานวน 194 อัตรา(รอยละ 22.27) ตามลําดับ  

สวนการบรรจุงานนั้น มีการบรรจุงานแรงงานท่ีมีการศึกษาระดับมัธยมศึกษามากท่ีสุด  
จํานวน 691 คน (รอยละ 49.71) รองลงมาไดแก รองลงมาไดแกระดับปวช.-ปวส./อนุปริญญา 
จํานวน 420 อัตรา (รอยละ 30.21) และระดับประถมศึกษาและต่ํากวา จํานวน 252 อัตรา (รอยละ 
18.12) ตามลําดับ 
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แผนภูมิ 13 เปรียบเทียบตําแหนงงานวาง ผูลงทะเบียนสมัครงาน บรรจุงาน จําแนกตามวุฒิการศึกษา 

ไตรมาส 2/2562 

     

 

2) การจัดหางานตางประเทศ 

2.1) จํานวนแรงงานไทยท่ีแจงความประสงคไปทํางานในตางประเทศ 

ในไตรมาส 2/2562 พบแรงงานในจังหวัดสมุทรสาครท่ีแจงความประสงคไปทํางานใน
ตางประเทศ เพศชาย จํานวน 3คน เพศหญิง จํานวน 5 คน 

2.2) จํานวนแรงงานไทยท่ีไดรับใบอนุญาตใหไปทํางานตางประเทศ 

การอนุญาตใหแรงงานไปทํางานตางประเทศของจังหวัดสมุทรสาครในไตรมาส 2/2562 พบวา   
มีจํานวนท้ังสิ้นจํานวน 46 คน โดยเม่ือพิจารณาตามวิธีการเดินทางพบวา สวนใหญเปนประเภท Re-Entry คือ
กลับไปทํางานอีกครั้งหนึ่งโดยการตออายุสัญญา จํานวน 45 คน (รอยละ 80.35) รองลงมาเปนประเภท         
นายจางพาไปทํางาน จํานวน 8 คน (รอยละ 14.28) ตามลําดับ  

แผนภูมิ 15 สัดสวนของแรงงานไทยท่ีไดรับอนุญาตใหเดินทางไปทํางานตางประเทศ 
จําแนกตามวิธีการเดินทาง ไตรมาส2/2562 
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2.3) ภูมิภาคท่ีแรงงานไทยเดินทางไปทํางาน 

แรงงานไทยท่ีเดินทางไปทํางานตางประเทศตามท่ีไดรับอนุญาตในไตรมาส 2/2562  
จํานวน 3 คน โดยไปทํางานในภูมิภาคตะวันออกกลางจํานวน 2 คน (รอยละ66.66)  และภูมิภาคอ่ืนๆ จํานวน  
1 คน (รอยละ 33.33)  

 

แผนภูมิ 16 สัดสวนของแรงงานไทยท่ีขออนุญาตเดินทางไปทํางานตางประเทศ             
จําแนกตามภูมิภาคท่ีเดินทางไปทํางาน ไตรมาส 2/2562 

 

 
 

3) แรงงานตางดาว 

สําหรับสถิติแรงงานตางดาว ซ่ึงหมายถึงแรงงานตางดาวท่ีเขามาทํางานในประเทศไทย  
กรมการจัดหางานจําแนกเปน 2 กลุม ใหญๆ คือ  

1. กลุมแรงงานตางดาวท่ีเขาเมืองถูกกฎหมาย ประกอบดวยประเภทตางๆ คือ  
(1) ประเภทตลอดชีพ  
(2) ประเภทชั่วคราวท่ีขออนุญาตทํางานตามมาตรา 9 (มาตรา 7 เดิม)  
(3) ประเภทสงเสริมการลงทุนและกฎหมายอ่ืนตามมาตรา 12 (มาตรา 10 เดิม)  
(4) ประเภทท่ีไดรับอนุญาตทํางานตามขอตกลง MOU  
(5) ประเภทพิสูจนสัญชาติและไดรับใบอนุญาตทํางาน  
เนื่องจากประเภทไดรับอนุญาตทํางานตามขอตกลง MOU (ขอ 4) และประเภทพิสูจน

สัญชาติ (ขอ 5) คือ กลุมแรงงานสัญชาติ ลาว กัมพูชา และเมียนมาท่ีเดินทางเขามาทํางานชั่วคราวเดิมเปน
แรงงานผิดกฎหมายภายหลังรัฐบาลไดดําเนินการจัดทําการพิสูจนสัญชาติ และลงนาม MOU เพ่ือใหการนําเขา
แรงงานใหเปนแรงงานถูกกฎหมาย ปจจุบันจึงไดจัด 2 ประเภทนี้ใหรวมอยูในกลุมแรงงานตางดาวถูกกฎหมาย 
  2. แรงงานตางดาวเขาเมืองผิดกฎหมายท่ีไดรับอนุญาตทํางาน (กลุมมาตรา 13)  
 (1) ชนกลุมนอย 
 (2) แรงงานตางดาว 3 สัญชาติ (เมียนมา ลาว กัมพูชา)  
                             ตามมติคณะรัฐมนตรี 22 มีนาคม 2559 
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3.1) จํานวนคนตางดาวท่ีไดรับอนุญาตทํางานคงเหลือ 
ขอมูล ณ วันท่ี 30 มิถุนายน 2562 จังหวัดสมุทรสาครมีคนตางดาวท่ีไดรับอนุญาตทํางาน

คงเหลือท้ังสิ้น จํานวน 265,318 คน ซ่ึงเม่ือจําแนกตามลักษณะการเขาเมืองของคนตางดาว 
กลุมคนตางดาวเขาเมืองถูกกฎหมายสวนใหญเปนคนเขาเมืองถูกกฎหมายมาตรา 9 ประเภท

พิสูจนสัญชาติจํานวน 160,093 คน (รอยละ 61.64 ของคนตางดาวเขาเมืองถูกกฎหมายท้ังหมด) รองลงมา
ไดแก มาตรา 9 ประเภทนําเขาตาม MOU จํานวน 95,850 คน (รอยละ 36.90) มาตรา 9 ประเภทท่ัวไป 
จํานวน 3,609 คน (รอยละ 1.39) และมาตรา 12 ประเภทสงเสริมการลงทุนจํานวน 153 คน (รอยละ 0.05) 
สําหรับกลุมคนตางดาวท่ี เปนชนกลุมนอยจํานวน 5,613 คน (รอยละ 2.11) 

 

แผนภูมิ 17 เปรียบเทียบจํานวนแรงงานตางดานถูกกฎหมายและผิดกฎหมาย  
ขอมูล ณ 30 มิถุนายน 2562 ในจังหวัดสมุทรสาคร 

 

 

 

4) การสงเสริมการมีงานทํา 

สํานักงานจัดหางานจังหวัดสมุทรสาครจัดกิจกรรมเพ่ือสงเสริมการมีงานทํา ในไตรมาส 2/2562 
มีกิจกรรมท่ีดําเนินการเพ่ือสงเสริมการมีงานทําท้ังหมด 3 กิจกรรม ไดแก  

1) กิจกรรมเพ่ิมอาชีพ เพ่ิมรายได จัดกิจกรรม 1 ครั้ง มีผูไดรับผลประโยชน จํานวน 12 คน (ชาย 2 
คน หญิง 10 คน) 

2) กิจกรรมเพ่ิมอาชีพ-เพ่ิมรายได จัดกิจกรรม 1 ครั้ง มีผูไดรับผลประโยชน จํานวน 20 คน (ชาย 2 
คน หญิง 18 คน) 

3) กิจกรรมสงเสริมการมีงานทําใหทหารกองประจําการท่ีจะปลดเปนทหารกองหนุน จํานวน 200 
(ชาย 200 คน ) 
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แผนภูมิ 19 เปรียบเทียบกิจกรรมท่ีดําเนินการเพ่ือสงเสริมการมีงานทํา 

จําแนกตามประเภทกิจกรรม ไตรมาส 2/2562 

 

 
 

3. การพัฒนาศักยภาพแรงงาน 

1) การพัฒนาฝมือแรงงาน 

ศูนยพัฒนาฝมือแรงงานจังหวัดสมุทรสาคร ไดดําเนินการพัฒนาผูใชแรงงานในรูปแบบตางๆ 
ไดแก  การฝกเตรียมเขาทํางาน  เปนการฝกอาชีพใหกลุมแรงงานใหมหรือผูถูกเลิกจาง วางงาน ท่ีประสงคเขา
สูตลาดแรงงานใหมีความรู ทักษะฝมือ  การฝกยกระดับฝมือแรงงาน   และการฝกเสริมทักษะ เปนการฝก
อาชีพใหแรงงานท่ีทํางานอยูแลวหรือถูกเลิกจางเพ่ือเพ่ิมความรู ทักษะและฝมือเฉพาะดานใหทันกับเทคโนโลยี
รวมสมัย สรางโอกาสการมีงานทํา การฝกประเภทนี้มีท้ังสวนท่ีกรมพัฒนาฝมือแรงงานดําเนินการเอง และการ
สงเสริมการพัฒนาฝมือแรงงานในภาคเอกชน นอกจากนี้ยังมีภารกิจทดสอบมาตรฐานฝมือแรงงาน เพ่ือเพ่ิม
ศักยภาพฝมือแรงงานไทยใหมีมาตรฐานฝมือสอดคลองและทัดเทียมกับมาตรฐานสากล ขณะเดียวกันเปนการ
พัฒนาทักษะใหสอดคลองกับความตองการของตลาดแรงงาน 

1.1) การฝกเตรียมเขาทํางาน 

การฝกเตรียมเขาทํางานในไตรมาส 2/2562 พบวา ไมมีผูเขารับการฝกเตรียมเขาทํางาน  

1.2) การฝกยกระดับฝมือแรงงาน 

สําหรับการฝกยกระดับฝมือแรงงานในไตรมาส 2/2562 พบวา มีผูเขารับการฝกยกระดับฝมือ
แรงงานท้ังสิ้นจํานวน 316 คน เม่ือพิจารณาตามกลุมอาชีพ พบวา ธุรกิจและบริการมีการฝกยกระดับฝมือ
แรงงานสูงสุดจํานวน 168 คน (รอยละ 53.16) รองลงมาคือ ชางไฟฟา อิเล็กทรอนิกส คอมพิวเตอร        
จํานวน 148 คน ตามลําดับ ท้ังนี้ผูผานการฝกยกระดับฝมือแรงงาน ในไตรมาสนี้ผานการฝกยกระดับฝมือ
แรงงานท้ังหมดจํานวน 118 คน กําลังอยูในชวงฝก 50 คน 
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แผนภูมิ 20 เปรียบเทียบจํานวนผูเขารับการฝกและผูผานการฝกยกระดับฝมือแรงงาน 
จําแนกตามกลุมอาชีพ ไตรมาส 2/2562 

 

 

2) การทดสอบมาตรฐานฝมือแรงงาน 

การทดสอบมาตรฐานฝมือแรงงานในไตรมาส 2/2562 พบวามีผูเขารับการทดสอบมาตรฐานฝมือ
แรงงานจํานวนท้ังสิ้น จํานวน 169 คน เม่ือพิจารณาตามกลุมสาขาอาชีพจะพบวากลุมอาชีพท่ีมีการทดสอบ  
มากท่ีสุด คือ กลุมชางชางไฟฟา อิเล็กทรอนิกส คอมพิวเตอร มีจํานวน 169 คนโดยมีผูท่ีผานการทดสอบ 
จํานวน 113 คน 

 

แผนภูมิ 21  เปรียบเทียบจํานวนผูเขารับการทดสอบและผูผานการทดสอบฝมือแรงงาน 
จําแนกตามกลุมอาชีพ ไตรมาส 2/2562 
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4. การคุมครองแรงงานและสวัสดิการ 

 การคุมครองลูกจาง/ผูใชแรงงานใหไดรับความเปนธรรมในการจางงานภายใตพระราชบัญญัติคุมครอง
แรงงาน พ.ศ. 2541 และแกไขเพ่ิมเติม (ฉบับท่ี 2) (ฉบับท่ี 3) พ.ศ. 2551 เพ่ือไมใหถูกเอารัดเอาเปรียบจาก
นายจางซ่ึงการดําเนินการดังกลาวนี้เปนหนาท่ีของสํานักงานสวัสดิการและคุมครองแรงงานโดยมีจุดมุงหมาย
สูงสุด คือใหลูกจางผูใชแรงงานมีคุณภาพชีวิตท่ีดีข้ึน มีรายไดและสวัสดิการท่ีเปนธรรมเพียงพอตอการ
ดํารงชีวิต ขณะเดียวกันในอีกดานหนึ่งก็ตองผดุงไวซ่ึงความยุติธรรมกับฝายนายจาง กลาวคือไมโอนเอียงไป
ดานใดดานหนึ่ง โดยการดําเนินการใหบรรลุวัตถุประสงคตามท่ีกลาวมาแลว สํานักงานสวัสดิการและคุมครอง
แรงงาน มีภารกิจ 4 ดาน คือ การคุมครองแรงงาน การจัดสวัสดิการแรงงาน การสงเสริมความปลอดภัยในการ
ทํางาน และการสงเสริมแรงงานสัมพันธ  

1) การตรวจแรงงาน 

    การตรวจแรงงาน คือ การตรวจสถานประกอบการซ่ึงเปนมาตรการหนึ่งในการคุมครองแรงงาน
เพ่ือใหแนใจวาผูใชแรงงานไดรับการปฏิบัติและดูแลตามกฎหมาย ขณะเดียวกันจะเปนมาตรการในการกํากับ
ดูแลและกระตุนใหสถานประกอบการปฏิบัติตามกฎหมายคุมครองแรงงานและเอาใจใสดูแลลูกจางของตนให
มากข้ึนอีกดวย อยางไรก็ตาม การตรวจสถานประกอบการมิใชเปนการไปจับผิดนายจาง หากแตเปนการตรวจ
เพ่ือแนะนําใหความรูในการปฏิบัติท่ีถูกตองแกนายจาง รวมท้ังสรางความเขาใจแกลูกจาง/ผูใชแรงงานเพ่ือให
ปฏิบัติใหถูกตองตามกฎหมายอีกดวย 

1.1) การตรวจคุมครองแรงงาน 

  ในไตรมาส 2/2562 (เมษายน – มิถุนายน 2562) สํานักงานสวัสดิการและคุมครองแรงงานจังหวัด
สมุทรสาคร ไดดําเนินการตรวจสถานประกอบการท้ังสิ้นจํานวน 74 แหง มีลูกจางท่ีผานการตรวจหรือไดรับ
การคุมครองรวม 11,934 คน จําแนกเปนชาย 5,085 คน (รอยละ 42.60 ของลูกจางท่ีผานการตรวจท้ังหมด) 
หญิงจํานวน 6,842 คน (รอยละ 57.33) ซ่ึงสถานประกอบการท่ีตรวจสวนใหญเปนสถานประกอบการท่ีมี 
ลูกจาง 10-19และ 20-49 คนจํานวน 17 แหง (คิดเปนรอยละ 22.97) รองลงมาเปนสถานประกอบการท่ีมี
ลูกจาง 50-99 คน จํานวน 15 แหง (รอยละ19.23) สถานประกอบการขนาด 100-299 คน จํานวน 13 แหง 
(รอยละ 17.57) สถานประกอบการขนาด 5-9  จํานวน 6 แหง (รอยละ 8.10) และสถานประกอบการขนาด 
1,000 คน จํานวน 2 แหง (รอยละ 2.70) ในสวนผลการตรวจ พบวา ในไตรมาสนี้สถานประกอบการรอยละ 
100.00 (จํานวน 74 แหง) ปฏิบัติถูกตองตามกฎหมาย  
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แผนภูมิ 22 สถานประกอบการท่ีปฏิบัติถูกตอง/ไมถูกตอง 
ตามกฎหมายคุมครองแรงงาน ไตรมาส 2/2562 

 

 

 

1.2) การตรวจความปลอดภัยในสถานประกอบการ 

ในไตรมาส 2/2562  สํ านั กงานสวัสดิการและคุมครองแรงงานจั งหวัดส มุทรสาคร           

ไดดําเนินการตรวจความปลอดภัยในสถานประกอบการท้ังสิ้นจํานวน 67 แหง ซ่ึงสถานประกอบการท่ีตรวจ  

สวนใหญเปนสถานประกอบการท่ีมีการจางงาน 20-49 คน จํานวน 17 แหง (คิดเปนรอยละ 25.37)  

รองลงมาเปนสถานประกอบการขนาด 10-19 และ 50-99 คน จํานวน 11 แหง (คิดเปนรอยละ 16.42)   

สถานประกอบการขนาด 100-299 คน จํานวน 3 แหง (คิดเปนรอยละ 14.92) และสถานประกอบการขนาด 

300-499 คนข้ึนไป จํานวน 5 แหง (คิดเปนรอยละ 7.46) ตามลําดับ ท้ังนี้  

จํานวนลูกจางท่ีผานการตรวจมีท้ังสิ้นจํานวน 17,219 คน เปนชาย 7,933 คน (คิดเปนรอยละ  

46.07 ของลูกจางท่ีผานการตรวจท้ังหมด) หญิง 9,286 คน (รอยละ 53.92) โดยลูกจางสวนใหญทํางาน        

ในอุตสาหกรรมการผลิต จํานวน 17,219 คน (รอยละ 100.00)  

ผลการตรวจความปลอดภัยตามขนาดของสถานประกอบการ พบวา สถานประกอบการ  

ปฏิบัติไมถูกตอง จํานวน 42 แหง และปฎิบัติถูกตอง 25 แหง (จากจํานวนสถานประกอบการท่ีตรวจ จํานวน 

67 แหง)  
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แผนภูมิ 24 เปรียบเทียบสถานประกอบการท่ีปฏิบัติถูกตอง/ไมถูกตองตามจากการตรวจความปลอดภัย 
ในการทํางาน ไตรมาส 2/2562 ในจังหวัดสมุทรสาคร 

 

 
แผนภูมิ 25 5 อันดับประเภทอุตสาหกรรมท่ีมีสถานประกอบการปฏิบัติถูกตอง/ไมถูกตองมากท่ีสุด  

ในการตรวจความปลอดภัยในการทํางาน ไตรมาส 2/2562 ของจังหวัดสมุทรสาคร 
 
 

 
 
 
 
 

2) แรงงานสัมพันธ 

2.1) องคการนายจางและลูกจาง 

      การสงเสริมและพัฒนาระบบแรงงานสัมพันธ  เพ่ือเสริมสรางความรวมมือท่ีดีตอกันระหวาง
นายจาง  ลูกจาง  และผูมีสวนเก่ียวของ  โดยมีเปาหมายหลักเพ่ือสรางสันติสุขในวงการแรงงาน ใหนายจางและ
ลูกจางมีทัศนคติท่ีดีตอกันในการทํางาน  ท้ังนี้  ในกลุมของนายจางและลูกจาง จะมีการตั้งองคการเพ่ือทํา
หนาท่ีเปนตัวแทนตนเอง โดยในไตรมาส 4/2561 ขอมูล ณ เดือนธันวาคม 2561 องคการนายจาง พบวามี
เพียงสมาคมนายจาง จํานวน 14 แหง สําหรับองคการลูกจาง มีเพียงสหภาพแรงงานในกิจการเอกชน 
จํานวน 36 แหง  



รายงานสถานการณแรงงานจังหวัดสมุทรสาคร ไตรมาส 2 ป 2562 

 

 
 41 

5. การประกันสังคม 

งานประกันสังคมเปนภารกิจของสํานักงานประกันสังคม กระทรวงแรงงาน โดยมีจุดมุงหมายเพ่ือดูแล
ผูใชแรงงานใหมีคุณภาพชีวิตท่ีดีข้ึนและมีหลักประกันชีวิตท่ีม่ันคงท้ังในยามปกติ กรณีเกิดการวางงาน รวมถึง
เม่ือยามแกชราโดยดําเนินการภายใตแนวคิดการเฉลี่ยทุกขเฉลี่ยสุข 

1) สถานประกอบการในระบบประกันสังคม 

1.1) จํานวนสถานประกอบการและผูประกันตน 

      ในไตรมาส 2 ป 2562 ขอมูล ณ มีนาคม จังหวัดสมุทรสาครมีสถานประกอบการท่ีข้ึน
ทะเบียนประกันสังคม จํานวน 10,907 แหง สําหรับผูประกันตน จํานวน 446,122 คน เม่ือพิจารณาจํานวน
สถานประกอบการจําแนกตามอุตสาหกรรม พบวา อุตสาหกรรมท่ีมีจํานวนสถานประกอบการ มากท่ีสุด 5 
อันดับแรก ไดแก  

1) การคา จํานวน 2,941 แหง (คิดเปนรอยละ 26.96 ของสถานประกอบการท้ังหมด)                     
2) ผลิตภัณฑจากโลหะ จํานวน 1,248 แหง (รอยละ 11.44) 
3) อุตสาหกรรมการผลิตอ่ืนๆ จํานวน 1,069 แหง (รอยละ 9.80) 
4) การผลิตอาหารและเครื่องดื่ม จํานวน 873 แหง (รอยละ 8.00)  
5) การกอสราง จํานวน 569 แหง (รอยละ 5.21)   

     เม่ือพิจารณาจํานวนผูประกันตนจําแนกรายอุตสาหกรรม พบวา อุตสาหกรรมท่ีมีจํานวน
ผูประกันตนมากท่ีสุด 5 อันดับแรก ไดแก  

1) การผลิตอาหารและเครื่องดื่ม จํานวน 81,862 (คิดเปนรอยละ18.35 ของจํานวน
ผูประกันตนท้ังหมด) 

2) อุตสาหกรรมการผลิตอ่ืนๆ จํานวน 57,363 (คิดเปนรอยละ 12.85 ของจํานวน
ผูประกันตนท้ังหมด) 

3) การผลิตสิ่งทอถัก เครื่องประดับ จํานวน 41,923 (คิดเปนรอยละ 9.40 ของจํานวน
ผูประกันตนท้ังหมด) 

4) ผลิตภัณฑจากโลหะ จํานวน 36,798 จํานวน (คิดเปนรอยละ 8.24 ของจํานวน
ผูประกันตนท้ังหมด) 

5) การคา จํานวน 35,385 (คิดเปนรอยละ7.93 ของจํานวนผูประกันตนท้ังหมด) 
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แผนภูมิ 27 5 อันดับประเภทอุตสาหกรรมท่ีมีจํานวนผูประกันตนมากท่ีสุด  

ไตรมาส 2/2562 

 
 

1.2) จํานวนสถานพยาบาลหลักในสังกัดประกันสังคม   

 ปจจุบันจังหวัดสมุทรสาคร มีสถานพยาบาลท่ีเปนเครือขายประกันสังคม จํานวน 8 แหง แยก
เปนสถานพยาบาลของรัฐบาลจํานวน 3 แหง คิดเปนรอยละ 37.50 ของสถานพยาบาลท้ังหมดและ
สถานพยาบาลเอกชนจํานวน 5 แหง (รอยละ 62.5)  

สําหรับรายชื่อสถานพยาบาลหลักในสังกัดประกันสังคมของรัฐ ไดแก โรงพยาบาล
สมุทรสาคร โรงพยาบาลกระทุมแบน และโรงพยาบาลบานแพว สวนสถานพยาบาลของเอกชน ไดแก  
โรงพยาบาลมหาชัย 2, โรงพยาบาลมหาชัย 3, โรงพยาบาลวิชัยเวชอินเตอรฯ สาขาสมุทรสาคร โรงพยาบาล
วิชัยเวชอินเตอรฯ สาขาออมนอย และ โรงพยาบาลวิภาราม 

 
แผนภูมิ 28 จํานวนสถานพยาบาลหลักในสังกัดประกันสังคม 

 

 

2) การใชบริการกองทุนประกันสังคม 

ในไตรมาส 2/2562 จํานวนผูประกันตนของจังหวัดสมุทรสาครท่ีมาใชบริการกองทุน
ประกันสังคมมีจํานวน 209,381 คน (หรือรอยละ 46.93 ของจํานวนผูประกันตนท้ังหมด) โดยประเภท
ประโยชนทดแทนท่ีผูประกันตนมาใชบริการสูงสุด ไดแก กรณีสงเคราะหบุตร จํานวน 144,770 คน หรือ 
รอยละ 69.14 ของผูใชบริการท้ังหมด รองลงมา คือ กรณีเจ็บปวย จํานวน 30,887 คน (รอยละ 14.75)  
กรณีชราภาพ จํานวน 17,532 คน (รอยละ 8.73) กรณีวางงาน จํานวน 10,520 คน (รอยละ 5.02)  
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เม่ือพิจารณาปริมาณการจายเงินประโยชนทดแทน จะพบวามีการจายเงินท้ังสิ้น 357.51 
ลานบาท โดยกรณีสงเคราะหบุตรมีการจายเงินสูงสุดถึง 135.78 รองลงมา กรณีชราภาพ 86.67. ลานบาท   
คิดเปนรอยละ 24.24 ของเงินประโยชนทดแทนท่ีจาย กรณีคลอดบุตร 52.59 ลานบาท (รอยละ 14.71)    

แผนภูมิ 29 จํานวนผูใชบริการของกองทุนประกันสังคม 

จําแนกตามประเภทประโยชนทดแทน ไตรมาส 2/2562 

 

 
 

 

3) การเลิกกิจการและเลิกจางงาน 

ในไตรมาส 2 ป 2562 มีสถานประกอบการจํานวน 223 แหงท่ีเลิกกิจการ โดยเปนสถานประกอบการ
ท่ีมีการจางงาน 1-9 คน จํานวน 201 แหงท่ีเลิกกิจการ (คิดเปนรอยละ 90.13 ของสถานประกอบการท่ีเลิก
กิจการท้ังหมด) และสถานประกอบการท่ีมีการจางงาน 10 คนข้ึนไปจํานวน 22 แหงท่ีเลิกกิจการ  
(รอยละ 9.87) ท้ังนี้ ลูกจางท่ีถูกเลิกจางมีจํานวน 1,070 คน โดยเปนลูกจางในสถานประกอบการขนาด 1-9 
คน จํานวน 452 คน (คิดเปนรอยละ 42.24 ของลูกจางท่ีถูกเลิกจาง) และลูกจางในสถานประกอบการขนาด 
10 คนข้ึนไป จํานวน 618 คน (รอยละ 57.76)  

แผนภูมิ 30 จํานวนสถานประกอบการท่ีเลิกกิจการและลูกจางท่ีถูกเลิกจาง 
จําแนกตามขนาดสถานประกอบการ ไตรมาส 2/2562 

                     

 



รายงานสถานการณแรงงานจังหวัดสมุทรสาคร ไตรมาส 2 ป 2562 
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6. ขอมูลคนพิการ 

 สํานักงานพัฒนาสังคมและความม่ันคงของมนุษยจังหวัดสมุทรสาคร มีภารกิจหลักในการดําเนินงาน
ดานการพัฒนาสังคม การสรางความเปนธรรมและความเสมอภาคในสังคม การสงเสริมและพัฒนาคุณภาพ
และความม่ันคงในชีวิต 

 ในไตรมาส 2/2562 จังหวัดสมุทรสาครมีจํานวนคนพิการท่ีข้ึนทะเบียนท้ังหมด 12,015 คน จําแนก
ตามเพศ พบวา เพศชาย จํานวน 6,638 คน คิดเปนรอยละ 55.24 ละเพศหญิง จํานวน 5,377 คน คิดเปนรอย
ละ 44.75 ซ่ึงจะเห็นไดวาเพศชายมีจํานวนคนพิการท่ีข้ึนทะเบียนมากกวาเพศหญิง 

 

แผนภูมิ 31 จํานวนคนพิการท่ีข้ึนทะเบียน จําแนกตามเพศ ไตรมาส 2 ป 2562 

 

 

 

เม่ือพิจารณาคนพิการท่ีข้ึนทะเบียนจําแนกตามประเภทความพิการ พบวา คนพิการสวนใหญประเภท
ทางการเคลื่อนไหวรางกาย จํานวน 5,119 คน คิดเปนรอยละ 42.60 (เพศชาย 2,811 คน เพศหญิง 2,308 
คน) รองลงมาเปนประเภททางการไดยินหรือสื่อความหมาย จํานวน 2,740 คน คิดเปนรอยละ 22.80  
(เพศชาย 1,345 คน เพศหญิง 1,378 คน) ทางสติปญญา จํานวน 1,116 คน คิดเปนรอยละ 9.28  
(เพศชาย 597 คน เพศหญิง 519 คน) ประเภทพิการมากกวา 1 ประเภท จํานวน 1,037 คน ประเภททาง
จิตใจหรือพฤติกรรม จํานวน 946 คน คิดเปนรอยละ 7.87 ตามลําดับ 

 

 

 

 

 

 

 

 



รายงานสถานการณแรงงานจังหวัดสมุทรสาคร ไตรมาส 2 ป 2562 
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แผนภูมิ 32 จํานวนคนพิการท่ีข้ึนทะเบียนจําแนกตามประเภทความพิการ ไตรมาส 2/2562 

 

 

7. ขอมูลผูสูงอายุ 

 ในไตรมาส 2/2562 จังหวัดสมุทรสาครมีจํานวนผูสูงอายุท้ังสิ้น 84,810 คน เพศชาย จํานวน 29,842
คน คิดเปนรอยละ 31.18 เพศหญิง 54,968 คน คิดเปนรอยละ 64.81จําแนกตามพ้ืนท่ี (อําเภอ)  
พบวาอําเภอกระทุมแบนมีจํานวนผูสูงอายุมากท่ีสุด จํานวน 36,196 คน คิดเปนรอยละ 42.67 รองลงมา  
อําเภอเมืองสมุทรสาคร จํานวน 32,547 คน คิดเปนรอยละ 38.38 และอําเภอบานแพว จํานวน16,067 คน  
คิดเปนรอยละ 18.94 

 

 

แผนภูมิ 33 จํานวนผูสูงอายุจําแนกตามพ้ืนท่ี (อําเภอ) ไตรมาส 2/2562 

 

 

 

 



รายงานสถานการณแรงงานจังหวัดสมุทรสาคร ไตรมาส 3 ป 2562 
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ตารางภาคผนวก 
 

 

 

 

 

 

 

 



รายงานสถานการณแรงงานจังหวัดสมุทรสาคร ไตรมาส 3 ป 2562 

 

   

 
 

47 

ตาราง 1 ประชากรและกําลังแรงงาน จําแนกตามสถานภาพแรงงาน  
ไตรมาส 3/2561 - ไตรมาส 3/2562 

หนวย: คน 

สถานภาพแรงงาน 
ไตรมาส 3 ป 

2561 
ไตรมาส 4 ป 

2561 
ไตรมาส 1 ป 

2562 
ไตรมาส 2 ป 

2562 

ไตรมาส  3 ป 2562 

ชาย หญิง รวม 

ผูมีอายุ  15  ปขึ้นไป 878,635 881,097 883,705 883,705    
1. ผูอยูในกําลังแรงงาน 706,452 713,244 707,496 707,496    
    1.1  ผูมีงานทํา 702,200 707,548 703,036 703,036    
    1.2  ผูวางงาน 4,252 5,696 4,460 4,460    
    1.3  ผูท่ีรอฤดูกาล 0 0 0 0    
2. ผูไมอยูในกําลังแรงงาน 172,183 167,853 176,209 176,209    
    2.1  ทํางานบาน 58,322 57,540 57,958 57,958    
    2.2  เรียนหนังสือ 44,663 45,751 49,985 49,985    
    2.3  อ่ืนๆ 69,198 64,562 68,266 68,266    
อัตราการมีงานทํา 99.39 99.20 99.37 99.37    
อัตราการวางงาน 0.60 0.80 0.63 0.63    

ที่มา: สํานักงานสถิติจังหวดัสมทุรสาคร 
 

 

 

 

 

 

 



รายงานสถานการณแรงงานจังหวัดสมุทรสาคร ไตรมาส 3 ป 2562 
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ตาราง 2  ผูมีงานทําจําแนกตามเพศและสถานภาพการทํางาน 
ไตรมาส 3/2561 - ไตรมาส 3/2562 

หนวย: คน 

สถานภาพการทํางาน 
ไตรมาส 3 ป 

2561 
ไตรมาส 4 ป 

2561 
ไตรมาส 1 ป 

2562 
ไตรมาส 2 ป 

2562 
ไตรมาส 3 ป 2562 

ชาย หญิง รวม 
นายจาง 10,288 7,824 12,948 11,794    

ลูกจางรัฐบาล 26,503 26,168 25,956 27,077    
ลูกจางเอกชน 506,992 525,747 488,157 481,411    
ทํางานสวนตัว 104,316 100,593 118,428 118,004    

ชวยธุรกิจครอบครัว 52,835 47,216 57,553 70,639    
การรวมกลุม 1,266 0 0 0    

รวม 702,200 707,548 703,036 708,925    
ที่มา: สํานักงานสถิติจังหวดัสมทุรสาคร 

 

 

 

 

 

 

 

 

 



รายงานสถานการณแรงงานจังหวัดสมุทรสาคร ไตรมาส 3 ป 2562 
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ตาราง 3  ผูมีงานทําจําแนกตามเพศและรายอุตสาหกรรม  
ไตรมาส 3/2561 - ไตรมาส 3/2562 

หนวย: คน 

อุตสาหกรรม 
ไตรมาส 3 ป 

2561 
ไตรมาส 4 ป 

2561 
ไตรมาส 1 ป 

2562 
ไตรมาส 2 
ป 2562 

ไตรมาส 3 ป 2562 

ชาย หญิง รวม 

ภาคเกษตรกรรม        

1.  เกษตรกรรม การปาไม และการประมง 45,269 37,454 50,169 57,467    

นอกภาคเกษตรกรรม 0 0 0 0    

2.  การทําเหมืองแร และเหมืองหนิ 0 0 415,605 0    

3.  การผลิต 423,882 439,398 1,350 407,890    

4.  การไฟฟา กาซ และการประปา 958 0 1,562 1,902    

5.  การจดัหานํ้า บําบัดนํ้าเสยี 597 0 28,631 1,889    

6.  การกอสราง 15,487 19,686 87,036 20,444    

7.  การขายสง การขายปลีก การซอมแซมยานยนต รถจักรยานยนตของใชสวน
บุคคล และของใชในครัวเรือน 

90,036 86,810 29,615 81,356    

8.  การขนสง สถานท่ีเก็บสินคา  และการคมนาคม 25,931 28,487 29,535 27,196    

9.  โรงแรม และภัตตาคาร 38,802 41,043 0 40,219    

10.  ขอมูลขาวสารและการสื่อสาร 1,501 975 6,222 2,145    

11.  กิจการทางการเงินและการประกันภัย 3,774 4,549 3,698 5,816    

12.  กิจการดานอสังหารมิทรัพย การใหเชา และกิจกรรมทางธุรกิจ 2,710 2,158 2,212 49,991    

13.  กิจกรรมทางวิชาชีพและเทคนิค 8,102 1,635 6,416 7,482    

14.  การบริหารและการสนับสนุน  2,043 8,170 10,755 2,707    

15.  การบริหารราชการและปองกันประเทศ 10,188 10,963 9,696 5,975    

16.  การศึกษา 14,241 14,131 4,829 10,776    

17.  งานดานสุขภาพ และงานสังคมสงเคราะห 5,983 3,488 5,070 9,475    



รายงานสถานการณแรงงานจังหวัดสมุทรสาคร ไตรมาส 3 ป 2562 
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อุตสาหกรรม 
ไตรมาส 3 ป 

2561 
ไตรมาส 4 ป 

2561 
ไตรมาส 1 ป 

2562 
ไตรมาส 2 
ป 2562 

ไตรมาส 3 ป 2562 

ชาย หญิง รวม 

18.  กิจกรรมศิลปะความบันเทิงนันทนาการ 2,693 1,592 8,173 6,672    

19.  กิจกรรมบรกิารดนอ่ืนๆ  8,470 5,888 2,462 13,041    

20.  ลูกจางในครัวเรือนสวนบุคคล 1,044 1,121 0 922    

21.  องคการระหวางประเทศและองคการตางประเทศอ่ืนๆ และสมาชิก 0 0 0 0    

22.  ไมทราบ 489 0 0 560    

รวม 702,200 707,548 703,036 708,925    
ที่มา: สํานักงานสถิติจังหวัดสมุทรสาคร  

 

 

 

 

 

 

 

 

 

 

 

 



รายงานสถานการณแรงงานจังหวัดสมุทรสาคร ไตรมาส 3 ป 2562 
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ตาราง 4  ผูมีงานทําจําแนกตามอาชีพ  
ไตรมาส 3/2561 - ไตรมาส 3/2562 

หนวย: คน 

อาชีพ 
ไตรมาส 3 ป 

2561 
ไตรมาส 4ป 

2561 
ไตรมาส 1ป 

2562 
ไตรมาส 2 ป 

2562 
ไตรมาส 3 ป 2562 

ชาย หญิง รวม 
1. ผูบัญญตัิกฎหมาย ขาราชการระดับอาวุโส และผูจัดการ 18,586 16,668 20,215 21,575    

2. ผูประกอบวิชาชีพดานตางๆ             20,892 19,484 22,614 25,126    

3. ผูประกอบวิชาชีพดานเทคนิคสาขาตางๆ และอาชีพท่ีเก่ียวของ 33,926 31,829 29,788 32,501    

4. เสมียน 41,837 44,395 34,463 31,706    

5. พนักงานบริการและพนักงานในรานคา และตลาด  110,217 100,823 103,228 111,414    

6. ผูปฏิบัติงานท่ีมฝีมือในดานการเกษตร  38,321 29,686 38,633 45,987    

7. ผูปฏิบัติงานดานความสามารถทางฝมือ และธุรกิจอ่ืนๆท่ีเก่ียวของ 107,327 118,143 118,588 98,501    

8. ผูปฏิบัติการโรงงานและเครื่องจักร และผูปฏิบัติงานดานการประกอบ 205,276 192,054 210,750 212,091    

9. อาชีพข้ันพ้ืนฐานตางๆ ในดานการขาย และการใหบริการ 125,329 154,466 124,757 130,024    

10. คนงานซึ่งมิไดจําแนกไวในหมวดอ่ืน             489 0 0 0    

ยอดรวม 702,200 707,548 703,036 708,925    

ที่มา: สํานักงานสถิติจังหวัดสมุทรสาคร 

 
 
 
 

 



รายงานสถานการณแรงงานจังหวัดสมุทรสาคร ไตรมาส 3 ป 2562 
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ตาราง 5  ผูมีงานทําจังหวัดสมุทรสาคร จําแนกตามระดับการศึกษา  
ไตรมาส 3/2561 - ไตรมาส 3/2562 

หนวย: คน 

ระดับการศึกษา 
ไตรมาส 3  
ป 2561 

ไตรมาส 4  
ป 2561 

ไตรมาส 1 
 ป 2562 

ไตรมาส 2 
 ป 2562 

ไตรมาส 3 ป 2562 
ชาย หญิง รวม 

1.  ไมมีการศึกษา 79,961 94,497 91,000 53,297    
2.  ต่ํากวาประถมศึกษา 54,623 46,001 53,247 56,862    
3.  ประถมศึกษา 122,899 124,422 133,903 121,231    
4.  มัธยมศึกษาตอนตน 141,984 122,476 134,776 152,952    
5.  มัธยมศึกษาตอนปลาย 95,793 101,531 70,129 82,551    
     -  สายสามญั 68,020 61,837 45,671 56,504    
     -  สายอาชีวศึกษา 26,737 39,694 23,511 26,047    
     -  สายวิชาการศึกษา 1,036 0 947 0    
6.  มหาวิทยาลัย 105,909 104,123 155,226 107,924    
    -  สายวิชาการ 60,246 62,014 71,985 65,960    
    -  สายวิชาชีพ 35,295 37,244 36,515 34,708    
    -  สายวิชาการศึกษา 10,368 4,865 6,726 7,256    
7.  การศึกษาอ่ืน ๆ 99,345 103,528 102,215 121,735    
8.  ไมทราบ 1,686 10,970 2,540 12,373    

รวม 702,200 707,548 703,036 708,925    
ที่มา: สํานักงานสถิติจังหวัดสมุทรสาคร 

 
 

 
 

 
 



รายงานสถานการณแรงงานจังหวัดสมุทรสาคร ไตรมาส 3 ป 2562 
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ตาราง 6 จํานวนผูวางงาน และอัตราการวางงาน  
ไตรมาส 3/2561 - ไตรมาส 3/2562 

หนวย: คน 

ระดับการศึกษา 
ไตรมาส 3 ป 

2561 
ไตรมาส 4 ป 

2561 
ไตรมาส 1 ป 

2562 
ไตรมาส 2 ป 

2562 
ไตรมาส 3 ป 2562 

ชาย หญิง รวม 
กําลังแรงงาน 706,452 713,244 334,607 712,329    

จํานวนผูวางงาน  4,252 5,696 4,460 3,404    

อัตราการวางงาน  0.60 0.8 0.5 0.5    

ที่มา: สํานักงานสถิติจังหวัดสมุทรสาคร  
หมายเหตุ: อัตราการวางงาน = (ผูไมมีงานทํา/กําลังแรงงานรวม)X100    

 

 

 

ตาราง 7 จํานวนแรงงานนอกระบบจําแนกรายอุตสาหกรรม ป 2560 - 2561 
หนวย: คน 

ประเภทอุตสาหกรรม 
ป 2560 ป 2561 

ชาย หญิง รวม ชาย หญิง รวม 
ภาคเกษตรกรรม 12,791 8,192 20,983 20,387 20,030 40,417 
1. เกษตรกรรม การลาสัตว การปาไม และการประมง 12,791 8,192 20,983 20,387 20,030 40,417 
นอกภาคเกษตรกรรม 79,141 53,770 132,911 0 0 0 
2. การทําเหมืองแร เหมอืงหิน 897 567 1,464 0 0 0 
3. การผลิต 11,199 8,738 19,937 7,409 7,604 15,013 
4. การไฟฟา กาซ และประปา 0 0 0 0 0 0 
5. การกอสราง 7,282 419 7,701 7,189 901 8,090 
6. การขายสง การขายปลีก การซอมแซมยานยนต รถจักรยานยนต ของใชสวนบุคคล และของใชในครัวเรือน 26,776 17,865 44,641 19,295 26,381 45,676 
8. โรงแรมและภัตตาคาร 12,618 19,605 32,223 7,781 18,291 26,072 
9. ขอมูลขาวสารและการส่ือสาร 450 0 450 122 0 422 



รายงานสถานการณแรงงานจังหวัดสมุทรสาคร ไตรมาส 3 ป 2562 
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ประเภทอุตสาหกรรม 
ป 2560 ป 2561 

ชาย หญิง รวม ชาย หญิง รวม 
10.การขนสง สถานที่เก็บสินคา และการคมนาคม 10,691 967 11,658 11,776 480 12,256 
11.การเปนส่ือกลางทางการเงิน 0 0 0 254 0 254 
12.กิจการดานอสังหาริมทรัพย การใหเชา และกิจกรรมทางธุรกิจ 2,608 472 3,080 578 774 1,352 
13.การบริหารและการสนับสนุน 737 0 737 748 234 982 
14.กิจกรรมวิชาชีพและเทคนิค 0 0 0 1,245 0 1,245 
15.การบริหารราชการ และการปองกันประเทศ รวมท้ังการประกันสังคมภาคบงัคับ 0 0 0 0 0 0 
16.การศึกษา 0 0 0 0 448 448 
17.งานดานสุขภาพ และงานสังคมสงเคราะห 0 991 991 0 154 154 
18.ศิลปะความบันเทิงและนันทนาการ 1,697 0 1,697 282 696 978 
19.กิจกรรมดานบริหารชุมชน สังคม และการบริหารสวนบุคคลอื่นๆ 4,186 3,636 7,821 3,591 3,868 7,459 
20.ลูกจางในครัวเรือนสวนบุคคล 0 248 248 0 0 0 
21.องคการระหวางประเทศและองคการตางประเทศอื่นๆและสมาชิก 0 0 0 0 0 0 
22.การจัดหาน้ํา การบาํบัดน้ําเสีย 0 263 263 0 0 0 
23.ไมทราบ 0 0 0 0 0 0 

รวม 91,932 61,962 153,894 80,957 79,861 160,818 
ที่มา: สํานักงานสถิติจังหวัดสมุทรสาคร 

 
 

 
 
 
 
 
 
 
 
 



รายงานสถานการณแรงงานจังหวัดสมุทรสาคร ไตรมาส 3 ป 2562 
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ตาราง 8 จํานวนแรงงานนอกระบบจําแนกรายอาชีพ ป 2560 - 2561 
หนวย: คน 

ประเภทอาชีพ 
ป 2560 ป 2561 

ชาย หญิง รวม ชาย หญิง รวม 
1. ผูบัญญตัิกฎหมาย ขาราชการระดับอาวุโส และผูจัดการ 6,030 0 6,030 4,739 646 5,385 
2. ผูประกอบวิชาชีพดานตางๆ             797 274 1,071 1,356 238 1,594 
3. ผูประกอบวิชาชีพดานเทคนิคสาขาตางๆ และอาชีพท่ีเก่ียวของ 679 263 942 3,283 604 3,887 
4. เสมียน 0 3,248 3,248 0 681 681 
5. พนักงานบริการและพนักงานในรานคา และตลาด  34,642 38,985 73,627 23,863 43,538 67,401 
6. ผูปฏิบัติงานท่ีมฝีมือในดานการเกษตร  9,816 5,600 15,416 18,800 17,949 36,749 
7. ผูปฏิบัติงานดานความสามารถทางฝมือ และธุรกิจอ่ืนๆท่ีเก่ียวของ 15,622 4,223 19,845 8,596 5,728 14,324 
8. ผูปฏิบัติการโรงงานและเครื่องจักร และผูปฏิบัติงานดานการประกอบ 13,923 1,985 15,908 14,081 2,206 16,287 
9. อาชีพข้ันพ้ืนฐานตางๆ ในดานการขาย และการใหบริการ 10,423 7,384 17,807 6,239 8,271 14,510 
10. คนงานซึ่งมิไดจําแนกไวในหมวดอ่ืน             0 0 0 0 0 0 

ยอดรวม 91,932 61,962 153,894 80,957 79,861 160,818 
ที่มา: สํานักงานสถิติจังหวัดสมุทรสาคร 

 

 

 

 

 

 

 



รายงานสถานการณแรงงานจังหวัดสมุทรสาคร ไตรมาส 3 ป 2562 
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ตาราง 9 ตําแหนงงานวาง ผูลงทะเบียนสมัครงาน และการบรรจุงาน  
ไตรมาส 2 ป 2562 – ไตรมาส 3 ป 2562 

 

กิจกรรม 
ไตรมาส 2 
ป 2562 

ไตรมาส 3 
ป 2562 

ตําแหนงงานวาง (อัตรา) 1,573  

ผูลงทะเบียนสมคัรงาน (คน) 871  

บรรจุงาน (คน) 1,390  

ที่มา: สํานักงานจัดหางานจังหวัดสมุทรสาคร 

 

 

ตาราง 10 ตําแหนงงานวาง ผูลงทะเบียนสมัครงาน และการบรรจุงาน จําแนกตามเพศ ไตรมาส 3 ป 2562 
 

กิจกรรม 
เพศ 

ชาย หญิง ไมระบุ 

ตําแหนงงานวาง (อัตรา)    

ผูลงทะเบียนสมคัรงาน (คน)    

บรรจุงาน (คน)    

ที่มา: สํานักงานจัดหางานจังหวัดสมุทรสาคร 

 
 
 



รายงานสถานการณแรงงานจังหวัดสมุทรสาคร ไตรมาส 3 ป 2562 
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ตาราง 11 ตําแหนงงานวาง และการบรรจุงาน จําแนกตามสาขาอุตสาหกรรม 
ไตรมาส 2 ป 2562 – ไตรมาส 3 ป 2562 

สาขาอุตสาหกรรม 
ไตรมาส 2 ป 2562 ไตรมาส 3 ป 2562 

ตําแหนงงาน บรรจุงาน ตําแหนงงาน บรรจุงาน 
วาง (อัตรา) (คน) วาง (อัตรา) (คน) 

ภาคเกษตรกรรม 0 0   
1.  เกษตรกรรม การลาสตัว และการปาไม 0 0   
2.  การประมง 0 0   

นอกภาคเกษตรกรรม 0 0   
3.  การทําเหมืองแร และเหมืองหนิ  0 0   
4.  การผลิต 1,311 949   
5.  การไฟฟา กาซ และการประปา 0 21   
6.  การกอสราง 0 9   
7.  การขายสง การขายปลีก การซอมแซมยานยนต รถจักรยานยนต ของใชสวนบุคคล และของใชในครัวเรือน 13 200   
8.  โรงแรม และภัตตาคาร 127 8   
9.  การขนสง สถานท่ีเก็บสินคา  และการคมนาคม 0 47   
10.  การเปนสื่อกลางทางการเงิน 24 17   
11.  กิจการดานอสังหารมิทรัพย การใหเชา และกิจกรรมทางธุรกิจ 0 0   
12.  การบริหารราชการ และการปองกันประเทศ รวมท้ังการประกันสังคมภาคบังคับ 0 0   
313.  การศึกษา 2 3   
164.  งานดานสุขภาพ และงานสงัคมสงเคราะห 0 6   
15.  กิจกรรมดานบริการชุมชน สงัคม และการบริการสวนบุคคลอ่ืน ๆ 40 46   
16.  ลูกจางในครัวเรือนสวนบุคคล 2 0   
17.  องคการระหวางประเทศและองคการตางประเทศอ่ืนๆ และสมาชิก 0 0   
18.  ไมทราบ 54 84   

รวม 1,573 1,390   
ที่มา : สํานักงานจัดหางานจังหวัดสมุทรสาคร 



รายงานสถานการณแรงงานจังหวัดสมุทรสาคร ไตรมาส 3 ป 2562 
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ตาราง 12 จํานวนตําแหนงงานวาง ผูสมัครงาน และการบรรจุงาน จําแนกตามอาชีพ          
ไตรมาส 2 ป 2562 – ไตรมาส 3 ป 2562 

 

ประเภทอาชีพ 
ไตรมาส 2 ป 2562 ไตรมาส 3 ป 2562 

ตําแหนงงาน ผูลงทะเบียน บรรจุงาน ตําแหนงงาน ผูลงทะเบียน บรรจุงาน 
วาง (อัตรา) สมัครงาน (คน)  (คน) วาง (อัตรา) สมัครงาน (คน)   (คน) 

ผูบัญญัติกฎหมาย ขาราชการระดบัอาวุฒิโส ผูจดัการ 52 23 47    
ผูประกอบวิชาชีพดานอ่ืนๆ 33 26 39    
ชางเทคนิคและผูปฏิบัติงานท่ีเก่ียวของ 156 88 191    
เสมียน เจาหนาท่ี 113 111 199    
พนักงานบริการ พนักงานขายในรานคาและตลาด 66 47 85    
ผูปฏิบัติงานฝมือดานการเกษตรและประมง (แปรรูปข้ันพ้ืนฐาน) 0 0 0    
ผูปฏิบัติงานโดยใชฝมือในธุรกิจตางๆ 186 60 121    
ผูปฏิบัติงานในโรงงาน ผูควบคุมเครื่องจักรและปฏิบัติงานดานการประกอบการ 149 93 126    
อาชีพงานพ้ืนฐาน 818 423 582    
ผูฝกงาน 0 0 0    

รวม 1,573 871 1,390    
ที่มา : สํานักงานจัดหางานจังหวัดสมุทรสาคร 

 

 
 
 
 
 
 
 

 



รายงานสถานการณแรงงานจังหวัดสมุทรสาคร ไตรมาส 3 ป 2562 
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ตาราง 13 จํานวนตําแหนงงานวาง ผูสมัครงาน และการบรรจุงาน จําแนกตามวุฒิการศึกษา  
ไตรมาส 2 ป 2562 – ไตรมาส 3 ป 2562 

  

วุฒิการศึกษา 
ไตรมาส 2 ป 2562 ไตรมาส 3 ป 2562 

ตําแหนงงาน ผูลงทะเบียน บรรจุงาน ตําแหนงงาน ผูลงทะเบียน บรรจุงาน 
วาง (อัตรา) สมัครงาน (คน) (คน) วาง (อัตรา) สมัครงาน (คน) (คน) 

ประถมศึกษาและต่ํากวา  256 194 252    
มัธยมศึกษา 669 469 691    
ปวช.-ปวส./อนุปริญญา 531 236 420    
ปริญญาตร ี 117 87 233    
ปริญญาโท 0 3 4    
ปริญญาเอก 0 0 0    
อ่ืน ๆ 0 0 0    

รวม 1,573 871 1,390    
ที่มา : สํานักงานจัดหางานจังหวัดสมุทรสาคร 
 

 

 

 

 

 

 

 



รายงานสถานการณแรงงานจังหวัดสมุทรสาคร ไตรมาส 3 ป 2562 
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ตาราง 14 จํานวนแรงงานไทยท่ีลงทะเบียนแจงความประสงคเดินทางไปทํางานตางประเทศ  
จําแนกตามระดับการศึกษา ไตรมาส 2 ป 2562 – ไตรมาส 3 ป 2562 

หนวย: คน 

ระดับการศึกษา 
ไตรมาส 2 ป 2562 ไตรมาส 3 ป 2562 

ชาย หญิง รวม ชาย หญิง รวม 
ประถมศึกษา 2 1 3    
มัธยมศึกษา 1 2 3    
ปวช. ปวส. ปวท. อนุปริญญา 0 1 1    
ปริญญาตร ี 0 1 1    
ปริญญาโท 0 0 0    
ปริญญาเอก 0 0 0    

รวม 3 5 8    
ท่ีมา : สํานักงานจัดหางานจังหวัดสมุทรสาคร 
 

ตาราง 15  จํานวนแรงงานไทยท่ีไดรับอนุญาตใหเดินทางไปทํางานตางประเทศ              
จําแนกตามวิธีการเดินทาง ไตรมาส 2 ป 2562 – ไตรมาส 3 ป 2562 

หนวย: คน 

วิธีการเดินทาง 
ไตรมาส 2 ป 2562 ไตรมาส 3 ป 2562 

จํานวน (คน) รอยละ (%) จํานวน (คน) รอยละ (%) 
บริษัทจัดหางานจัดสง 0 0.00   
Re-Entry 45 84   
เดินทางดวยตนเอง 3 8   
นายจางพาไปฝกงาน 0 0.00   
นายจางพาไปทํางาน 8 14.29   
กรมการจดัหางานจดัสง 0 0.00   

รวม 56 100.00   
ท่ีมา : สํานักงานจัดหางานจังหวัดสมุทรสาคร 



รายงานสถานการณแรงงานจังหวัดสมุทรสาคร ไตรมาส 3 ป 2562 
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ตาราง 16  จํานวนแรงงานไทยท่ีขออนุญาตเดินทางไปทํางานตางประเทศ    
จําแนกตามภูมิภาคท่ีเดินทางไปทํางาน ไตรมาส 2 ป 2562 – ไตรมาส 3 ป 2562 

หนวย: คน 

ภูมิภาค 
ไตรมาส 2 ป 2562 ไตรมาส 3 ป 2562 

จํานวน (คน) รอยละ (%) จํานวน (คน) รอยละ (%) 
เอเชีย 0 8.00   
ตะวันออกกลาง 2 80.00   
แอฟริกา 0 0.00   
ภูมิภาคอ่ืน ๆ 1 12.00   

รวม 3 100.00   
ท่ีมา : สํานักงานจัดหางานจังหวัดสมุทรสาคร 

 
 

 

 

 

 

 

 

 

 

 

 



รายงานสถานการณแรงงานจังหวัดสมุทรสาคร ไตรมาส 3 ป 2562 
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ตาราง 17 จํานวนคนตางดาวท่ีไดรับอนุญาตทํางานคงเหลือจําแนกตามลักษณะการเขาเมือง ขอมูล ณ 30 มิถุนายน 2562 ของจังหวัดสมุทรสาคร 
หนวย: คน 

ป 

คนตางดาวเขาเมืองถูกกฎหมาย คนตางดาวเขาเมืองผิดกฎหมาย 

รวมทั้งสิ้น 
ม. 9 ม.12 

รวม 

ม. 13 

รวม ตลอดชีพ ชั่วคราวทั่วไป 
ชั่วคราว (MOU) สงเสริมการลงทุน 

(BOI) 
ชนกลุมนอย 

มติ ครม. 3 

สัญชาต ินําเขา 
MOU 

พิสูจนสัญชาต ิ

ถึง ณ 30 ม.ิย. 

62 
0 3,609 95,850 160,093 153 259,705 5,613 0 5,613 265,318 

ท่ีมา : สํานักงานจัดหางานจังหวัดสมุทรสาคร 
หมายเหตุ : มติ ครม. 3 สัญชาติ ไมมแีรงงานตางดาวหลบหนีเขาเมือง เนื่องจาก เด็กกลุมบัตรชมพูและใบคัดกรองไดดําเนินการพิสูจนสัญชาติแลว 

 

ตาราง 18 กิจกรรมท่ีดําเนินการเพ่ือสงเสริมการมีงานทํา 

จําแนกตามประเภทกิจกรรม ไตรมาส 3 ป 2562 

 

กิจกรรมท่ีดําเนินการ จํานวนคร้ัง ผูไดรับประโยชน(คน) 

เพ่ือสงเสริมการมีงานทํา ท่ีจัดกิจกรรม ชาย หญิง รวม 

1. กิจกรรมเพ่ิมอาชีพ เพ่ิมรายได     

2.กิจกรรมแนะแนวอาชีพและสงเสริมการมีงานทําใหผู
ถูกคุมขังในเรือนจําศูนยวิวัฒนพลเมืองและสถานพินิจ 

    

รวม     

ท่ีมา : สํานักงานจัดหางานจังหวัดสมุทรสาคร 
 
 
 



รายงานสถานการณแรงงานจังหวัดสมุทรสาคร ไตรมาส 3 ป 2562 
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ตาราง 19 ผลการฝกเตรียมเขาทํางาน/ยกระดับ/ทดสอบมาตรฐานฝมือแรงงานจําแนกตามกลุมอาชีพ 
ไตรมาส 3 ป 2562 

หนวย: คน 

กลุมอาชีพ 
การฝกเตรียมเขาทํางาน การฝกยกระดับฝมือแรงงาน การทดสอบมาตรฐานฝมือแรงงาน 

ผูเขา รอยละ ผูผาน รอยละ ผูเขา รอยละ ผูผาน รอยละ ผูเขา รอยละ ผูผาน รอยละ 
1. ชางกอสราง             

2. ชางอุตสาหการ             

3. ชางเครื่องกล             

4. ชางไฟฟา อิเล็กทรอนิกส คอมพิวเตอร             

5. ชางอุตสาหกรรมศิลป             

6. เกษตรอุตสาหกรรม             

7. ธุรกิจและบริการ             

รวม             

ท่ีมา: ศูนยพัฒนาฝมือแรงงานจังหวัดสมุทรสาคร 

 

 

 

 

 

 

 

 



รายงานสถานการณแรงงานจังหวัดสมุทรสาคร ไตรมาส 3 ป 2562 
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ตาราง 20 การตรวจแรงงาน จําแนกตามสถานประกอบการ ไตรมาส 3 ป 2562 (กรกฎาคม- กันยายน 2562) 

 
ขนาดสถาน
ประกอบการ 

สถานประกอบการท่ี
ผานการตรวจ (แหง) 

ลูกจางท่ีผานการตรวจ (คน) ผลการตรวจ (แหง) การดําเนินการของเจาหนาท่ี (แหง) 

ชาย หญิง เด็ก รวม ปฏิบัติ
ถูกตอง 

ปฏิบัติ
ไม

ถูกตอง 

แนะนํา ออก
หนังสือ
เรียกพบ 

ออกคําสั่ง
ใหปฏิบัติ 

เปรียบเทียบ
ปรับ 

ดําเนินคดี  
ขั้นพนกังาน
สอบสวน 

1 - 4 คน             
5 - 9 คน             

10 - 19 คน             
20 - 49 คน             
50 - 99 คน             

100 - 299 คน             
300 - 499 คน             
500 – 999 คน             
1,000 คนข้ึนไป             

รวม             
ท่ีมา: สํานักงานสวัสดิการและคุมครองแรงงานจังหวัดสมุทรสาคร 

 
 
 
 
 

 
 

 



รายงานสถานการณแรงงานจังหวัดสมุทรสาคร ไตรมาส 3 ป 2562 
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ตาราง 21 เรื่องท่ีสถานประกอบการปฏิบัติไมถูกตองตามกฎหมายคุมครองแรงงาน 

ไตรมาส 3 ป 2562 ในจังหวัดสมุทรสาคร 
 

ประเภทอุตสาหกรรม 
 
 

เร่ืองท่ีปฏิบัติไมถูกตอง (แหง) 

วันทํางาน เวลาทํางาน เวลาพัก 
เงินประกนั

ในการ
ทํางาน 

วัน 
หยุด 

สิทธิการ
ลา 

การจาย
คาจาง 

คาลวงเวลา
และคาทํางาน 

คาจาง
ข้ันต่ํา 

ขอ 
บังคับ 

ทะเบียน 
ระยะ 
เวลา 

จายคาจาง 

สถานที่จาย
คาจาง 

สวัสดิการ 

1.  เกษตรกรรม การลาสัตว และการปาไม               

2.  การประมง               

3.  การทําเหมืองแร และเหมอืงหิน                

4.  การผลิต               

5.  การไฟฟา กาซ และการประปา               

6.  การกอสราง               

7.  การขายสง ขายปลีก การซอมแซมยานยนต               

8.  โรงแรม และภัตตาคาร               

9.  การขนสง สถานที่เก็บสินคา และการคมนาคม               

10.  การเปนส่ือกลางทางการเงิน               

11.  กิจการดานอสังหาริมทรัพย กจิกรรมทางธุรกิจ               

12.  การบริหารราชการ และการปองกนัประเทศ               

13.  การศึกษา               

14.  งานดานสุขภาพ และงานสังคมสงเคราะห               

15.  กิจกรรมดานบริการชุมชน สังคม ฯ               

16.  ลูกจางในครัวเรือนสวนบุคคล               

17.  องคการระหวางประเทศ องคกรตางประเทศ               

18.  ไมทราบ               

รวม               

ท่ีมา: สํานักงานสวัสดิการและคุมครองแรงงานจังหวัดสมุทรสาคร 

 

 

 

 



รายงานสถานการณแรงงานจังหวัดสมุทรสาคร ไตรมาส 3 ป 2562 
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ตาราง 22 การตรวจความปลอดภัยในการทํางานจําแนกตามขนาดของสถานประกอบการ 
ไตรมาส 3 ป 2562 ในจังหวัดสมุทรสาคร 

ขนาดสถาน
ประกอบการ 

สถาน
ประกอบการ
ท่ีผานการ

ตรวจ (แหง) 

ลูกจางท่ีผานการตรวจ (คน) ผลการตรวจ (แหง) การดําเนินการของเจาหนาท่ี (แหง) 

ชาย หญิง เด็ก รวม ปฏิบัติ
ถูกตอง 

ปฏิบัติ
ไม

ถูกตอง 

แนะนํา ออกคําสั่ง สงเร่ือง
ดําเนินคดี สง

เอกสาร 
พบ ปรับปรุง หยุดการ

ใช
เคร่ืองจักร 

1 - 4 คน              
5 - 9 คน              

10 - 19 คน              
20 - 49 คน              
50 - 99 คน              

100 - 299 คน              
300 - 499 คน              
500 – 999 คน              
1,000 คนข้ึนไป              

รวม              
ท่ีมา: สํานักงานสวัสดิการและคุมครองแรงงานจังหวัดสมุทรสาคร 

 

  

 

 

 

 

 



รายงานสถานการณแรงงานจังหวัดสมุทรสาคร ไตรมาส 3 ป 2562 
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ตาราง 23 การตรวจความปลอดภัยในการทํางานจําแนกตามอุตสาหกรรม                          

ไตรมาส 2 ป 2562 ในจังหวัดสมุทรสาคร 

ประเภทอุตสาหกรรม 
สปก.ที่ผาน
การตรวจ 

(แหง) 

ลูกจางที่ผาน
การตรวจ (คน) 

ผลการตรวจ (แหง) การดําเนินการของเจาหนาที่ (แหง) 

ปฏิบตัิ
ถูกตอง 

ปฏิบตัิไม
ถูกตอง 

แนะนํา 
 สงเรื่อง

ดําเนินคด ีสงเอกสาร พบ ปรับปรุง หยุดใชเครื่องจักร 
1.  เกษตรกรรม การลาสัตว และการปาไม 0 0 0 0 0 0 0 0 0 0 
2.  การประมง 0 0 0 0 0 0 0 0 0 0 
3.  การทําเหมืองแร และเหมอืงหิน  0 0 0 0 0 0 0 0 0 0 
4.  การผลิต 67 17,219 25 420 0 0 0 39 0 3 
5.  การไฟฟา กาซ และการประปา 0 0 0 0 0 0 0 0 0 0 
6.  การกอสราง 0 0 0 0 0 0 0 0 0 0 
7.  การขายสง การขายปลีก การซอมแซม 0 0 0 0 0 0 0 0 0 0 
8.  โรงแรม และภัตตาคาร 0 0 0 0 0 0 0 0 0 0 
9.  การขนสง สถานที่เก็บสินคา  และการคมนาคม 0 0 0 0 0 0 0 0 0 0 
10.  การเปนส่ือกลางทางการเงิน 0 0 0 0 0 0 0 0 0 0 
11.  กิจการดานอสังหาริมทรัพย การใหเชา และกจิกรรมทางธุรกจิ 0 0 0 0 0 0 0 0 0 0 
12.  การบริหารราชการ และการปองกนัประเทศ รวมทั้งการประกันสังคม 0 0 0 0 0 0 0 0 0 0 
13.  การศึกษา 0 0 0 0 0 0 0 0 0 0 
14.  งานดานสุขภาพ และงานสังคมสงเคราะห 0 0 0 0 0 0 0 0 0 0 
15.  กิจกรรมดานบริการชุมชน สังคม และการบริการสวนบุคคลอื่น ๆ 0 0 0 0 0 0 0 0 0 0 
16.  ลูกจางในครัวเรือนสวนบุคคล 0 0 0 0 0 0 0 0 0 0 
17.  องคการระหวางประเทศและองคการตางประเทศอื่นๆ และสมาชกิ 0 0 0 0 0 0 0 0 0 0 
18.  ไมทราบ 0 0 0 0 0 0 0 0 0 0 

รวม 67 17,219 25 420 0 0 0 39 0 3 
ที่มา: สํานักงานสวัสดิการและคุมครองแรงงานจังหวัดสมุทรสาคร 

 

 
 
 



รายงานสถานการณแรงงานจังหวัดสมุทรสาคร ไตรมาส 3 ป 2562 
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ตาราง 24 จํานวนองคการนายจาง จําแนกตามประเภทองคการ 
ไตรมาส 2 ป 2562 

ประเภทองคการ จํานวน (แหง) 
สมาคมนายจาง 11 
สหพันธนายจาง 0 
สภาองคการนายจาง 0 

รวม 11 
ที่มา: สํานักงานสวัสดิการและคุมครองแรงงานจังหวัดสมุทรสาคร  
 

ตาราง 25 จํานวนองคการลูกจาง จําแนกตามประเภทองคการ 
 ไตรมาส 2 ป 2562 

ประเภทองคการ จํานวน (แหง) 
สหภาพแรงงานรัฐวิสาหกิจ 0 
สหภาพแรงงานในกิจการเอกชน 30 
สหพันธแรงงาน 0 
สภาองคการลูกจาง 0 

รวม 30 
ที่มา: สํานักงานสวัสดิการและคุมครองแรงงานจังหวัดสมุทรสาคร  
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ตาราง 26 ขอเรียกรอง ขอพิพาท ขอขัดแยง ไตรมาส 1 ป 2562 – ไตรมาส 2 ป 2562 

ขอเรียกรอง/ขอพิพาท/ขอขัดแยง ไตรมาส 1 ป 2562 ไตรมาส 2 ป 2562 
แหง คร้ัง คน แหง คร้ัง คน 

การแจง/ยุติขอเรียกรอง 0 0 0 0 0 0 
1.  การแจงขอเรยีกรอง 0 0 0 1 1 897 
2.  การยตุิขอเรียกรอง 0 0 0 1 1 897 
     2.1  การยุตโิดยไมเกิดขอพิพาทแรงงาน 0 0 0 0 0 0 
             -  ตกลงกันเอง 0 0 0 1 1 897 
             -  ถอนขอเรียกรอง 0 0 0 0 0 0 
             -  อ่ืน ๆ 0 0 0 0 0 0 
     2.2  การเกิดขอพิพาทแรงงาน 0 0 0 0 0 0 
3.  ขอเรียกรองยังไมยตุ ิ 0 0 0 0 0 0 

การเกิดขอพิพาท/ยุติขอพิพาท 0 0 0 0 0 0 
1.  การเกิดขอพิพาทแรงงาน 0 0 0 0 0 0 
2.  การยตุิขอพิพาทแรงงาน 0 0 0 0 0 0 
           -  ยุติภายใน  5  วัน 0 0 0 0 0 0 
           -   ยุติเกิน  5  วัน 0 0 0 0 0 0 
           -  ช้ีขาดโดยบังคับ 0 0 0 0 0 0 
           -  ช้ีขาดโดยสมัครใจ 0 0 0 0 0 0 
           -  อ่ืน ๆ  0 0 0 0 0 0 
3.  ขอพิพาทแรงงานยังไมยุต ิ 0 0 0 0 0 0 

การเกิดขอขัดแยง/ยุติขอขัดแยง 0 0 0 0 0 0 
1.  การเกิดขอขัดแยง 3 3 255 0 0 0 
2.  การยตุิขอขัดแยง 0 0 0 0 0 0 
          -  ตกลงกันได 3 3 255 0 0 0 
          -  ถอนเรื่อง 0 0 0 0 0 0 
          -  ฟองศาลแรงงาน 0 0 0 0 0 0 



รายงานสถานการณแรงงานจังหวัดสมุทรสาคร ไตรมาส 3 ป 2562 
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ขอเรียกรอง/ขอพิพาท/ขอขัดแยง ไตรมาส 1 ป 2562 ไตรมาส 2 ป 2562 
แหง คร้ัง คน แหง คร้ัง คน 

3.  การผละงาน 0 0 0 0 0 0 
4.  ขอขัดแยงยังไมยตุ ิ 0 0 0 0 0 0 
ท่ีมา: สํานักงานสวัสดิการและคุมครองแรงงานจังหวัดสมุทรสาคร 

 

ตาราง 27 จํานวนสถานประกอบการและผูประกันตนจําแนกตามอุตสาหกรรม  

ไตรมาส 1 ป 2562 – ไตรมาส 2 ป 2562 

ประเภทอุตสาหกรรม 
ไตรมาส 1 ป 2562 ไตรมาส 2  ป 2562 

สปก.(แหง) ผปต.(คน) สปก.(แหง) ผปต.(คน) 
1. การสํารวจ การทําเหมืองแร 7 82 7 82 
2. การผลติอาหารเครื่องดืม่ 873 81,862 873 81,862 
3. การผลติสิ่งทอถัก เครื่องประดบั 523 41,923 523 41,923 
4. การทําปาไม ผลิตภณัฑจากไม 179 5,633 179 5,633 
5. ผลิตภัณฑจากกระดาษ การพิมพ 291 13,559 291 13,559 
6. ผลิตภัณฑเคมี นํ้ามันปโตรเลียม 335 9,563 335 9,563 
7. ผลิตภัณฑจากแรอโลหะ 56 3,459 56 3,459 
8. การผลติโลหะข้ันมลูฐาน 36 3,026 36 3,026 
9. ผลิตภัณฑจากโลหะ 1,248 36,798 1,248 36,798 
10. ผลิต ประกอบยานพาหนะ 79 9,072 79 9,072 
11. อุตสาหกรรมการผลติอ่ืน ๆ 1,069 57,363 1,069 57,363 
12. สาธารณูปโภค 69 1,321 69 1,321 
13. การกอสราง 569 10,297 569 10,297 
14. การขนสง การคมนาคม 221 4,568 221 4,568 
15. การคา 2,941 35,385 2,941 35,385 
16. ประเภทกิจการอ่ืน ๆ 2,411 132,211 2,411 132,211 
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ประเภทอุตสาหกรรม 
ไตรมาส 1 ป 2562 ไตรมาส 2  ป 2562 

สปก.(แหง) ผปต.(คน) สปก.(แหง) ผปต.(คน) 
รวม 10,907 446,122 10,907 446,122 
ท่ีมา: สํานักงานประกันสังคมจังหวัดสมุทรสาคร 

ตาราง 28 จํานวนสถานพยาบาลหลักในสังกัดประกันสังคม 
 

ประเภทสถานพยาบาล แหง 

รัฐบาล 3 

เอกชน 5 

รวม 8 

ท่ีมา: สํานักงานประกันสังคมจังหวัดสมุทรสาคร  
 

ตาราง 29 การใชบริการของกองทุนประกันสังคมจําแนกตามประเภทประโยชนทดแทน     
(ไมเนื่องจากการทํางาน) ไตรมาส 1 ป 2562 – ไตรมาส 2 ป 2562 

 

ประเภทประโยชนทดแทน ไตรมาส 1 ป 2562 ไตรมาส 2 ป 2562 
ราย ลานบาท ราย ลานบาท 

1.  เจ็บปวย 30,887 30,318,825.96 2399 26.65 
2.  คลอดบุตร 3,903 52,594,915.00 4388 58.71 
3.  ทุพพลภาพ 1,321 3,468,869.55 1206 3.60 
4.  ตาย 448 11,932,380.85 424 10.86 
5.  สงเคราะหบุตร 144,770 135,788,900.00 103192 68.54 
6.  ชราภาพ 17,532 86,716,73.22 18825 83.70 
7.  วางงาน 10,520 36,742,063.38 11586 41.08 

รวม 209,381 357,517,654.96 163620 293.15 
ท่ีมา: สํานักงานประกันสังคมจังหวัดสมุทรสาคร 
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ตาราง 30 จํานวนสถานประกอบการท่ีเลิกกิจการและลูกจางท่ีถูกเลิกจาง 
จําแนกตามขนาดสถานประกอบการ ) ไตรมาส 2 ป 2562 (เมษายน-มิถุนายน 2562) 

 

ขนาดสถานประกอบการ 
ไตรมาส 1 ป 2562 ไตรมาส 2 ป 2562 

สถานประกอบการท่ีเลิกกจิการ (แหง) ลูกจางท่ีถกูเลิกจาง  (คน) สถานประกอบการท่ีเลิกกจิการ (แหง) ลูกจางท่ีถกูเลิกจาง  (คน) 
1 - 9  คน 201 452 297 639 

10 คนข้ึนไป 22 618 31 741 
รวม 223 1,070 328 1,380 

   ท่ีมา : สํานักงานประกันสังคมจังหวัดสมุทรสาคร 
 

ตาราง 31 จํานวนคนพิการท่ีข้ึนทะเบียนจําแนกตามประเภทความพิการ ไตรมาส 2 ป 2562 

ประเภท 
ไตรมาส 2 ป 2562 

ชาย หญิง รวม 
1. ทางการเห็น 271 260 531 
2. ทางการไดยินหรือสื่อความหมาย 1362 1,378 2,740 
3. ทางการเคลื่อนไหวรางกาย 2811 2,308 5,119 
4. ทางจิตใจหรือพฤติกรรม 571 375 946 
5. ทางสติปญญา 597 519 1,116 
6. ทางการเรียนรู 257 72 329 
7. ทางออทิสติก 169 28 197 
8. พิการมากกวา 1 ประเภท 600 437 1,037 

รวม 6,638 5,377 12,015 
   ท่ีมา : สํานักงานพัฒนาสังคมและความมั่นคงของมนุษยจังหวัดสมุทรสาคร 
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ตาราง 32 จํานวนผูสูงอายุจําแนกตามพ้ืนท่ีและเพศ 

อําเภอ 
ไตรมาส 1 ป 2562 

ชาย หญิง รวม 
1. อําเภอเมืองสมุทรสาคร 136,149 146,481 282,630 
2. อําเภอกระทุมแบน 82,994 88,198 171,192 
3. อําเภอบานแพว 47,074 50,326 97,400 

รวม 266,217 285,005 551,222 
ท่ีมา : สํานักงานสงเสริมการปกครองทองถิ่นจังหวัดสมุทรสาคร 

 

ตาราง 33 ตัวช้ีวัดภาวะแรงงานจังหวัด 

ตัวช้ีวัด 2/ 2561 3/2561 4/ 2561 1/ 2562 2/ 2562 

อัตราการมีสวนรวมในกําลังแรงงานของจังหวัด 78.74 80.40 80.95 80.06 80.06 

อัตราการจางงานในภาคเกษตรของจังหวัด 6.33 6.44 5.29 6.15 8.10 

อัตราการจางงานนอกภาคเกษตรของจังหวัด 93.67 93.55 94.71 59.11 91.89 

อัตราการจางงานในอุตสาหกรรมการผลิตของจังหวัด 59.82 60.36 62.10 74.73 57.53 

อัตราการบรรจุงานตอผูสมัครงานจังหวัด 151.18 159.23 152.63 234.90 159.59 

อัตราการบรรจุงานตอตําแหนงงานวางจังหวัด 89.54 225.06 149.52 69.65 88.37 

อัตราการวางงานในจังหวัด 0.32 0.60 0.80 0.50 0.63 

อัตราการเปลี่ยนแปลงของผปต.ในระบบประกันสังคม (มาตรา 33) (YOY) (สปส.) 19.78 17.57 16.19 -3.80 -5.66 

อัตราการเปลี่ยนแปลงของผปต.ท่ีขอรับประโยชนทดแทนกรณีวางงาน (YOY) (สปส.) -41.82 17.02 -5.66 14.77 20.42 

อัตราการเปลี่ยนแปลงของผปต.ท่ีข้ึนทะเบียนขอรับประโยชนทดแทนกรณีเลิกจาง (YOY)  483.79 28.83 62.48 35.10 39.60 

อัตราการไมปฏิบัติตามกฎหมายคุมครองแรงงานของสถานประกอบกิจการ 4.44 3.28 2.80 0.00 4.45 
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ตัวช้ีวัด 2/ 2561 3/2561 4/ 2561 1/ 2562 2/ 2562 

อัตราการไมปฏิบัติตามกฎหมาย ความปลอดภัย ของสถานประกอบกิจการ 19.44 7.69 3.39 0.00 16.80 

รอยละของสถานประกอบกิจการท่ีเขาสูระบบประกันสังคมในจังหวัด 83.80 85.69 80.39 78.16 96.79 

อัตราแรงงานท่ีเปนผูประกันตนในจังหวัด 76.33 76.30 76.45 76.15 64.53 

ท่ีมา : สํานักงานประกันสังคมจังหวัดสมุทรสาคร 
      : สํานักงานสวัสดิการและคุมครองแรงงานจังหวัดสมุทรสาคร 
      : สํานักงานจัดหางานจังหวัดสมุทรสาคร 
      : สํานักงานพัฒนาธุรกิจการคาจังหวัดสมุทรสาคร 
      : สํานักงานสถิติจังหวัดสมทุรสาคร 
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